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Legal information 
Use of the application examples 

The application examples represent example solutions of automation tasks combined with 
multiple components in the form of text, graphics and/or software modules. The application 
examples are a cost-free service of Siemens AG and/or a subsidiary company of Siemens AG 
("Siemens"). They are not binding and do not claim to be complete or functional with regard to 
configuration or equipment. The application examples do not represent customer-specific 
solutions, but rather only provide help for typical tasks. You yourself are responsible for the proper 
and safe operation of products in compliance with the applicable regulations. You must check the 
function of the respective application example and adapt it specifically to your system. 
Siemens grants you the non-exclusive, non-sublicensable and non-transferable right of use of the 
application examples by professionally trained personnel. Any change to the application examples 
is made at your own risk. Transfer to third parties or duplication of the application examples or 
extracts thereof is only permitted in combination with your own products. The application 
examples do not necessarily undergo the usual tests and quality checks of a paid product, may 
contain functional and performance defects and may be subject to errors. You are responsible for 
ensuring that the application examples are used in such a way that any defective functions do not 
lead to property damage or bodily injury. 

Disclaimer of liability 
Siemens excludes its liability, irrespective of the legal ground, in particular for the usability, 
availability, completeness and freedom from defects of the application examples, as well as 
associated notes, configuration data and performance data and any damage caused by these. 
This does not apply if Siemens is compulsorily liable, e.g. under product liability law, in cases of 
intent, gross negligence, culpable injury to life, body or health, failure to comply with a guarantee, 
fraudulent concealment of a defect or culpable breach of essential contractual obligations. The 
claims for compensation for the breach of essential contractual obligations are, however, limited 
to the foreseeable damage, typical for the type of contract, except in the event of intent or gross 
negligence or injury to life, body or health. The above provisions do not imply a change in the 
burden of proof to your detriment. You exempt Siemens from any third-party claims that may exist 
or arise in this connection, unless Siemens is compulsorily liable by law. 
By using the application examples, you agree that Siemens cannot be made liable for any 
possible damage beyond the liability provisions described. 

Additional information 
We reserve the right to make changes to these application examples at any time without prior 
notice. If there are any discrepancies between the recommendations provided in these application 
examples and other Siemens publications – e.g. catalogs – the contents of the other documents 
have priority. 
In addition to this, the Siemens terms and conditions of use apply 
(https://support.industry.siemens.com). 

Security information 
Siemens provides products and solutions with industrial security functions that support the secure 
operation of plants, systems, machines and networks. 
In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security concept. 
Siemens’ products and solutions only form one element of such a concept. 
The customer is responsible for preventing unauthorized access to its plants, systems, machines 
and networks. Systems, machines and components should only be connected to the enterprise 
network or the Internet where necessary and with appropriate security measures (e.g . use of 
firewalls and network segmentation) in place.  
Additionally, Siemens' guidance on appropriate security measures should be taken into account. 
For more information about industrial security, please visit: 
https://www.siemens.com/industrialsecurity.  
Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends applying product updates as soon as they are available, and 
always using the latest product version. Use of product versions that are no longer supported, and 
failure to apply latest updates may increase customer’s exposure to cyber threats.  
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS feed 
at: https://www.siemens.com/industrialsecurity.  

https://support.industry.siemens.com/
https://www.siemens.com/industrialsecurity
https://www.siemens.com/industrialsecurity
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1 Introduction 

1.1 Overview  

The HMI toolbox of Siemens Industry Online Support provides many useful tools 
that can clearly make every day work easier.   

The different tools are available in global libraries and can thus be easily integrated 
in your visualization. This saves you valuable development time that you would 
have to invest in the development of your own tools. 

In addition to the library "106226404_LHmiToolbox_WinCC_Comfort_Adv 
V15.1.zip", the application example offers you an example project 
"106226404_HmiToolbox_WinCC_Comfort_Adv_V15.1.zip" to become familiar 
with the tool and to test it.  

This documentation provides a description of how to use the example project. It 
also explains the operating principle and procedure for integrating the tool into your 
own user project. 

 

Figure 1-1 

 

 

The HMI toolbox comprises tools for six different subject areas. 

• Time functions – abbreviation "LHmiTime" 

• Data transfer – abbreviation "LHmiData" 

• Mathematical functions – abbreviation "LHmiMath" 

• Simplified operation – abbreviation "LHmiOper" 

• Increase clarity – abbreviation "LHmiView" 

• Simplified engineering – abbreviation "LHmiEng" 
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In the sample project, you open each tool in the tool overview picture using its own 
button that is stored in the library. A text (tool name) and image (tool symbol) are 
visible on the button for the associated tool. 

The following tables explain which text and which image is used for the individual 
tools. 

"Time functions" subject area 

Table 1-1 

Name Symbol Description 

Alarm 
 

Alarm function 

Calendar 
 

Calendar function 

Stopwatch 
 

Stopwatch with five lap 
times 

Timer 
 

Timer function with five 
adjustable timers 

Time switch 
 

Time switch function with 
defined trigger bit 

World clock 
 

Option for integrating world 
clocks 

"Data transfer" subject area 

Table 1-2 

Name Symbol Description 

Chat 
 

Chat function via http 

Barcode 
 

Using barcode fonts 

QR Code 
 

QR Code generator 

Email 
 

Manual and automatic 
sending of emails 

Automatic data backup of 
files  

Option for automatic data 
backup 

"Mathematical functions" – subject area 

Table 1-3 

Name Symbol Description 

Unit converter 
 

Unit converter 

Calculator 
 

Windows-independent 
calculator 

"Simplified operation" subject area 

Table 1-4 

Name Symbol Description 

On-Screen Keyboard 
 

Own on-screen keyboards 

Home button 

 

Button that distinguishes 
between short and long 
pressing and executes an 
event to match the pressing 
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Name Symbol Description 

duration 

Individual screen saver  
Individual screen saver 
(solution 1)  

Screen saver 

HMI-triggered 

Individual screen saver  
Individual screen saver 
(solution 2) 

 

Screen saver 

PLC-triggered 

Check/radiobox 
 

Check and radio boxes 

Move Pop-up screens 
Move Pop-up screens  

Option for moving pop-up 
screens in Runtime 

Segmented control 
 

Segmenting of tag values 

"Increase clarity" subject area 

Table 1-5 

Name Symbol Description 

Notes 
 

Notes function during 
runtime 

Gauge Controls for Basic 
Panels  

Gauge control for Basic 
Panel 

Gauge Controls for Comfort 
Panel /WinCC RT Advanced 

 

Gauge control for Comfort 
Panels and WinCC RT 
Advanced 

File explorer 
 

Own file explorer, 
customizable 

Table View for Logs  To display archives 

Changing background by 
call of Pop-Up screens 
Changing background by 
call of Pop-Up screens 

 

Hiding a background by call 
of pop-up screen 

Waiting view 
 

Waiting view for operators 

Percentage view 
Percentage view  

Display integer percentage 
values. 

Bit monitor 

 
Status display for 8, 16, and 
32 bit value 

"Simplified engineering" subject area 

Table 1-6 

Name Symbol Description 

Rotation tool 

 

PowerPoint Add-In  

Creating multiple rotating 
graphics from a graphic for 
integration into a graphic list 

Siemens icon font 

 

Font with typical and 
frequently used, graphical 
icons 
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Note The HMI toolbox is available for a variety of HMI operator panels. 

• Basic HMI (Key Panels, Basic Panels) 

• Advanced HMI Panel-based (Comfort Panels, Comfort PRO Panels,  
Outdoor Panels, Mobile Panels) 

• Advanced HMI PC-based (SIMATIC Panel PCs and Embedded Bundles with 
WinCC RT Advanced / Professional) 

 

Due to the different hardware and software requirements, not all tools are 
available for all HMI operator panels or can only be operated on one HMI 
operator panel. In some cases a PLC is required in combination.  

You should therefore note the hardware and software requirements at the 
beginning of each tool section. 
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1.2 Principle of operation 

Some tools only work in combination with a PLC. For these tools, the library 
contains function blocks and data blocks for the PLC.  

The input and output data are stored in the communication data blocks 
"LHmiTime_CommDB" and "LHmiOper_CommDB".  

The data blocks serve as interface to the HMI operator panel. You access this data 
via the HMI tags of the tools. Operation takes place via the HMI operator panel. 

Figure 1-2 

PROFINET / IE

LHmiOper_CheckPanelActivity

LHmiOper_CommDB

LHmiOper_DelayButton

LHmiTime_Alarm

LHmiTime_Stopwatch

LHmiTime_Timer

LHmiOper_CommDB
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1.3 Components used 

This application example was created with these hardware and software 
components:  

Table 1-7 

Component Quantit
y 

Article number Note 

S7-1516-3 PN/DP V2.5 1 6ES7 516-3AN01-0AB0 Other S7-1500 are also 
possible, FW ≥ V2.0 

TP700 Comfort 1 6AV2 124-0JC01-0AX0 Other Comfort Panels ≥ 
7" display size or PC 
station with WinCC RT 
Advanced ≥ V15.1 can 
also be used 

STEP 7 Professional V15 
/ V15.1 

1 6ES7822-1..05-.. Engineering license for 
STEP 7 Professional 
required 

WinCC Engineering V15 
/ V15.1 

1 6AV210.-....5-0 Engineering license for 
WinCC Advanced 
required 

WinCC Runtime 
Advanced V15 / V15.1 

1 6AV2104-....5-0 Comfort Panels ≥ 7" 
display size can also be 
used 

Microsoft Power Point 
2010 

1   

 

This application example consists of the following components:  

Table 1-8 

Component File name Note 

TIA Portal 
project 

106226404_HmiToolbox_WinCC_Comfort_Adv_V15.1.zip Created with 
V15.1 

Library 106226404_LHmiToolbox_WinCC_Comfort_Adv 
V15.1.zip 

Created with 
V15.1 for 
integration 
into your own 
project 

Font 106226404_SiemensIconFont.zip Symbol font 
of the 
Siemens AG 

Power Point 
AddOn 

106226404_RotationTool.zip Tool for 
creating 
rotation 
graphics 
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2 Engineering  

2.1 Hardware configuration of the example project 

Figure 2-1 

 

 

2.2 Project engineering / configuration 

Note For this section you need to download the project, unzip it and open it with the 
TIA Portal. 

The project was developed with TIA Portal V15.1. You need STEP 7 
Professional and WinCC Comfort / Advanced with the associated licenses to 
open and edit the project. 

 

2.2.1 Adapting the hardware configuration 

If you only want to simulate the configuration, go to section 2.2.4. 

If you want to download the project to your hardware, you need to adapt the 
hardware configuration (IP address, PROFINET name, device type). 

Adapting IP address and PROFINET name 

1. Open the graphical area of the network view with "Project tree > Devices & 
networks" > Network view". 

2. Select the Ethernet port of the device. 

Figure 2-2 
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3. Open the settings of the PROFINET interface and change the IP address / 
PROFINET name to one of your choice. 

Figure 2-3 

 

 

4. Repeat this step for the other devices. Make sure that all devices are located in 
the same IP address range. 

 

Device replacement 

1. Open the settings for "Resize screen for device replacement" using the menu 
"Options > Settings > Visualization > Resize screen". 

2. Specify the settings for screen resizing, position of objects in the screen as well 
as exemption rules for specific objects. 

3. Open the shortcut menu of the device you want to replace by right clicking on it 
and click "Change device / version".  
("Change device / version"). 

Figure 2-4 
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4. The associated dialog window opens. Select an HMI operator panel with the 
firmware version of your choice, and confirm the entries with the "OK" button. 

Figure 2-5 

 

5. Check your screens and adjust any object shifts, if necessary. 
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2.2.2 Integrating style for toolbox 

The screen objects of the tools use the "styleTemplate V2.0.7" style. To retain the 
style, you must apply this style to your configuration.  

1. Open the "LHmiToolbox" library. There you will find the style. 

Figure 2-6 

 

2. Open the Runtime settings of your operator panel under "Project tree > 
Runtime settings". 

3. Apply the style for your operator panel. 

Select the option "Adapt font size to style". 

Figure 2-7 
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2.2.3 Downloading project to devices 

1. Select the PLC "PLC_1" in the "Project tree". 

2. Download the hardware configuration and the software to the device with the 
"Download to device" button in the toolbar. 

Figure 2-8 

 

3. Parameterize the "Extended download to device" dialog window: 

a. Setting the PG/PC interface settings 

b. Find the device with the "Start search" button. 

c. Select the device in the table of found devices. 

d. Confirm the dialog with the "Load" button. 

Figure 2-9 

 

When loading the panel, make sure that the type of the PG/PC interface in the 
dialog window matches the transfer channel setting ("Start Center Vxx.x.x.x> 
Settings > Transfer > Transfer Channel") on the panel. 

4. Repeat the loading step for the remaining devices. 

Note 
The PC station with WinCC RT Advanced only contains the "Chat" tool to 
demonstrate the function. Alternatively, you can omit download of the PC 
station or start the simulation (section 2.2.4), if WinCC RT Advanced is not 
installed. 
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2.2.4 Simulating the project 

Alternatively, you can also simulate the components to become familiar with the 
tools. To do so, you must have installed PLCSIM and the WinCC RT Advanced 
Simulator. These are often installed by default. 

 

Note Note the following during simulation: 

• A simulation is not suitable for permanent operation. For a simulation you 
download the hardware configuration and software to the associated 
devices. 

• You can only simulate one HMI operator panel at one time. 

• You can only simulate one PLC with PLCSIM. 

• Basic / Comfort Panel are only simulated with the WinCC RT Advanced 
Simulator. This must be observed for data access via scripting. 
The programming of scripts with file access is designed so that the scripts 
automatically detect the operating system and adapt the file access. 

Simulation of PLC with PLCSIM 

1. Select the PLC "PLC_1" in the "Project tree". 

2. Start the simulation with the "Start simulation" button  
in the toolbar. 

Figure 2-10 

 

3. Confirm the warning dialog to disable all other interfaces during the simulation 
with the "OK" button. 

Figure 2-11 

 

The PLCSIM and the "Extended download to device" dialog window opens. 

Figure 2-12 
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4. Parameterize the "Extended download to device" dialog window: 

a. Setting the PG/PC interface settings 

b. Search for the device with the "Start search" button. 

c. Select the device in the table of found devices. 

d. Confirm the settings with the "Load" button. 

Figure 2-13 
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5. The "Load preview" dialog window opens.  
Use the "Load" button to download the hardware configuration and the 
software to the PLCSIM. 

Figure 2-14 

 

 

6. The "Load results" dialog window opens.  

Select the "Start module" option to set the PLC to "RUN" mode after the 
download.  

Close the download with the "Finish" button. 

Figure 2-15 

 

  



2 Engineering 

 

Toolbox für HMI-Projekte 
Entry ID: 106226404,    V5.0,    02/2019   22 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

7. PLCSIM switches to "RUN" mode.  
You close the simulation with the "X" button of the PLCSIM. 

Figure 2-16 

 

 

Simulation of the HMI operator panel with WinCC RT Advanced Simulator 

1. Select the HMI operator panel in the project tree. 

2. Start the simulation with the "Start simulation" button  
in the toolbar. 

Figure 2-17 

 

3. The simulation is started after successful compilation of the software. You 
close the simulation with the "X" button of the WinCC RT Advanced Simulator 
or in the "Settings" menu area. 
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2.3 Using the library 

1. Download the library "106226404_LHmiToolbox_WinCC_Comfort_Adv 
V15.1.zip" and unzip the file. 

2. Open your WinCC configuration.  

3. Open the "Global libraries" pane in the "Libraries" task card. 

Figure 2-18 

 

4. Open the library with the "Open global library". 

Figure 2-19 

 

Select the file "LHmiToolbox.al15" and open the library with the "Open" button. 
The library is now visible in the "Global libraries" pane. 

Figure 2-20 

 

5. You will find the types and objects of the individual tools sorted by subject area 
and tools. 
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Drag the types and objects to the associated structure of your configuration of 
the operator panel in the "Project tree". 

Figure 2-21 
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2.4 Operation 

2.4.1 Application example user interface 

1. Open the overview page of the application example. 

Figure 2-22 

 

2. Click on the menu button and then on the Tools button to open the tools 
overview page. 

Figure 2-23 

 

3. Click on a tool of your choice. 

Figure 2-24 

 

4. Use the Back button in the status bar to jump to the previous screen. 

Figure 2-25 
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5. Click on the "More tools" button to switch between the tool overviews. 

Figure 2-26 

 

  



2 Engineering 

 

Toolbox für HMI-Projekte 
Entry ID: 106226404,    V5.0,    02/2019   27 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

2.4.2 Navigation options within the tools 

Page navigation on the left 

1. Click on a button in the page navigation to open the associated screen. 

Figure 2-27 

 

InScreen navigation 

1. Click on a button in the InScreen navigation to change the visibility of the 
associated objects. 

Figure 2-28 
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2.5 Error handling  

Display of ##### in I/O fields 

Figure 2-29 

 

 

If ##### is displayed in the faceplate for device information, there is a 
communication problem with the HMI operator panel for control. 

 

Perform the steps listed below: 

• Check whether the connecting cables are wired correctly or show any signs of 
damage. 

• Check whether the PG/PC interface is set correctly. 

https://support.industry.siemens.com/cs/ww/en/view/38717202 

You can find the settings under "Control Panel> Set PG/PC interface". 

• Check whether the devices are in the same network. 

• Check whether the IP address of the device is blocked in the network router. 

 

The process values are displayed after the communication error has been 
remedied. 

 

https://support.industry.siemens.com/cs/ww/en/view/38717202
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3 Time functions - Calendar 

3.1 General description 

The calendar provides an overview of individual days of the current and the next 
month. The current day is highlighted in blue.  

You can enter up to 30 appointments in the calendar. The calendar will remind you 
of any pending events that are scheduled. 

The appointments are saved in the file system of the operator panel so that they 
are still available after restarting Runtime or the operator panel. 

This tool does not depend on a PLC. The calculations are performed by the HMI 
operator panel. 

 

Figure 3-1 

 

 

3.1.1 Hardware and software components 

This tool is valid for: 

• SIMATIC WinCC Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels,  
Mobile Panels 2nd Generation  

• SIMATIC WinCC RT Advanced V15.1 
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3.1.2 VBS scripts used 

This section explains the functions of the scripts used in the tool. 

LHmiTime_vbsCalendarEvent 

The "LHmiTime_vbsCalendarEvent" script is used for event management. The 
script handles the following tasks: 

• Initialize the event entries 

• Create and save a new event 

• Delete an existing event 

• Transfer the parameters to the associated HMI tags 
 

The events are stored in the "events.txt" file with the associated time stamp and 
reminder text. The storage path of the file is: 

• Panels: \flash\106226404_Tools\   

• WinCC RT Advanced: C:\106226404_Tools\  

LHmiTime_vbsCalendarSaveOldEvent 

The "LHmiTime_vbsCalendarSaveOldEvent" script saves the pending event (time 
stamp and reminder text) to the associated HMI tag for display in the status bar of 
the tool. 

LHmiTime_vbsGenerateCalendar 

The "LHmiTime_vbsGenerateCalendar" script generates the calendar overview 
with the current month and next month based on the current date. 

LHmiTime_vbsShowEventPage 

Depending on the status of the scroll bar, the "LHmiTime_vbsShowEventPage" 
script shows the screen with the events 1-6, 7-12, 13-18, 19-24, 25-30. 

LHmiTime_vbsTransferSenderDate 

The "LHmiTime_vbsTransferSenderDate" script imports the date of the selected 
day in the calendar, opens the screen for creating a new event.  In addition, the 
script transfers the current date to the input screen for a new event. 
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3.2 Integration into the user project 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiTime > Calendar" 
of the library. 

3. Drag the elements (Template, Screens, Scripts, Tag table, Tasks) to the 
corresponding folder of the operator panel. 

Figure 3-2 

 

 

Note 

Depending on the size of the HMI operator panel, it may be necessary to adapt 
the screens. 

4. Open the "LHmiTime_vbsGenerateCalender" and 
"LHmiTime_vbsCalendarEvent" scripts at the "Set up" event of your start 
screen so that the events are loaded after a restart. 
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5. When you adapt the size of the calendar, enter the changed height or width of 
a calendar day I/O field as start value for the tags "calendarFieldHeight" and 
"calendarFieldWidth" in the "LHmiTime_CalendarTags" tag table.  
The position of the selection frame is calculated based on these tags. 

6. Drag the "btnCalendar" button from the library to your screen. You open the 
tool with this button. 

7. Download the software to your HMI operator panel or start the simulation.  
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3.3 Operation  

1. Open the visualization on your operator panel or simulate it. 

2. Open the Tools overview and click on the "Calendar" button. 

Use the arrow buttons to switch between current month and the next month. 
To create an event, click on a day. A screen opens in which you can create a 
new event.  

Alternatively, you can use the page navigation on the left to open the screen. 

Figure 3-3 

 

3. Adapt the date / time / event text and save the event with the "ADD" button.  

Figure 3-4 

4
 

 

The next event is displayed in the status bar. 
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4. Click on the "Events Overview" button. 
All entered events are listed in the table. 

You delete an event with the associated recycle bin button. 

Figure 3-5 

 

The event is deleted and the next pending event is displayed in the status bar. 

5. When the date and time of an event is reached, the screen with the calendar 
overview of the current month is opened and the associated event text with a 
button to confirm the event is shown in the status bar. 

6. Confirm the pending event with the "OK" button. 

Figure 3-6 

 

3.4 Error handling 

When you add an event in the past, an alarm with the alarm text "Date is in the 
past" with alarm ID "60000" is triggered. You can view the alarm in the "Alarm 
view" control. No new event is created. Repeat your entry and select an event in 
the future.  
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4 Time functions – Time-of-day alarm / Alarm 

4.1 General description 

You can use the time-of-day alarm / alarm to be reminded of a specific event in 
Runtime at a specific time (time-of-day). 

The time must be set in the format (hh:mm:ss) by means of three I/O fields directly 
in the screen. The time-of-day alarm / alarm is enabled with a switch. 

The PLC compares the current time with the time of the time-of-day alarm / alarm 
and triggers an alarm when the set time has been reached. 

In the status bar you can see when the alarm has expired and acknowledge it. 

If you close the screen before the alarm is triggered, the alarm is still maintained.  

 

Figure 4-1 

 

 

4.1.1 Hardware and software components 

This application example is valid for: 

• SIMATIC STEP 7 Basic / Professional V15.1 

• SIMATIC WinCC Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels,  
Mobile Panels 2nd Generation  

• SIMATIC WinCC RT Advanced V15.1 

• SIMATIC S7-1500 
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4.1.2 Data types and function blocks used 

This section explains the functions of the function blocks and data types used in 
the tool. 

FC "LGF_DTLtoString"  

The function block "LGF_DTLtoString" has been applied from the "Library with 
general functions (LGF) for STEP 7 (TIA Portal) and S7-1200 / S7-1500" library. 
This block converts a date component of the data type "DTL" to a character string 
of the format "String".  

The link to the entry page of the library is available in the document list under \3\. 

FB "LHmiTime_Alarm" 

The function block "LHmiTime_Alarm" compares the entered alarm time with the 
system time. If both match, the function block sets an "elapsed" alarm status and 
returns the current system time "elapsedTime". 

 

Figure 4-2 LHmiTime_Alarm 
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Table 4-1: Parameters of LHmiTime_Alarm 

Name P type Data type Comment 

hour IN Int Time-of-day alarm, specification in hours 

minute IN Int Time-of-day alarm, specification in minutes 

second IN Int Time-of-day alarm, specification in seconds 

reset IN Bool Time-of-day alarm, hours 

elapsed OUT Bool Time-of-day alarm, trigger for pop-up screen 

elapsedTime OUT String Time-of-day alarm, time stamp for HMI 

state IN_OUT Bool Status feedback function block 
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4.2 Integration into the user project 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiTime > Alarm" of 
the library. 

3. Drag the elements (Template, Screen, Tag table) to the corresponding folder of 
the operator panel. 

Figure 4-3 

 

Note 

Depending on the size of the HMI operator panel, it may be necessary to adapt 
the screen. 
If your HMI connection to the PLC is not called "HMI_Connection_1", update 
your HMI connection in the tag table. 

You must also synchronize the HMI tags again with the PLC tags. 

4. Drag the "btnAlarm" button from the library to your screen. You open the tool 
with this button. 

5. Open the folder "Master copies > > 01_PLC > 03_Tools > 01_Blocks > 
LHmiTime" of the library. 
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6. Drag the data block " LHmiTime_CommDB" to the "Program blocks" folder of 
your PLC. 

Figure 4-4 

 

All tags that are required for the time-of-day alarm have the prefix "alarm". 
Delete all other tags from the data block if you do not need them. 

7. Open the folder "Types > 03_Tools > 01_Blocks > LHmiTime > Alarm" of the 
library. 

8. Drag the function block "LHmiTime_Alarm" to the "Program blocks" folder of 
your PLC. 

Figure 4-5 

 

9. Call the function block "LHmiTime_Alarm" in your user program and 
interconnect the inputs and outputs with the corresponding tags of the 
communication DB. 

Figure 4-6 
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10. Download the software to your operator panel and your PLC or start the 
simulation. 
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4.3 Operation  

1. Open the visualization on your operator panel or simulate it. 

2. Open the Tools overview and click on the "Alarm" button. 

3. Enter the time and the reminder text for the time-of-day alarm. Enable the 
alarm with the "Enable" switch. 

Figure 4-7 

 

4. When the time-of-day alarm is enabled, the screen with the alarm is opened 
and the associated reminder text with a button to confirm the alarm is shown in 
the status bar.  

5. Acknowledge the pending time-of-day alarm with the "OK" button. 

Figure 4-8 
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5 Time functions – Stopwatch 

5.1 General description 

You can monitor and record the duration of production steps in your plant with the 
stopwatch.  

You start and stop the stopwatch with the "START" / "STOP" buttons. There are 
additional buttons to measure the lap times and reset them. The PLC calculates 
the lap time.  

The stopwatch can save up to 5 lap times and display them on your HMI operator 
panel. The stopwatch stops once the five lap times have been recorded.  

The stopwatch does not stop running when you close the screen. 

 

Figure 5-1 

 

 

5.1.1 Hardware and software components 

This application example is valid for: 

• SIMATIC STEP 7 Basic / Professional V15.1 

• SIMATIC WinCC Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels,  
Mobile Panels 2nd Generation  

• SIMATIC WinCC RT Advanced V15.1 

• SIMATIC S7-1500 
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5.1.2 Data types and function blocks used  

This section explains the functions of the function blocks and data types used in 
the tool. 

Data type "LHmiTime_typeRoundStopWatch" 

The data type "LHmiTime_typeRoundStopWatch " defines the stop/lap times as 
data format "Time" as well as the associated number of minutes and seconds. 

 

Table 5-1: Parameters of typeRound 

Name Data type Comment 

time Time Total time 

min Int Number of minutes 

sec Int Number of seconds 

FB "LHmiTime_Stopwatch" 

The function block "LHmiTime_Stopwatch" starts an internal timer that calculates 
the stop time "total" as well as the individual lap times ("round1" – "round5").  

 

Figure 5-2 LHmiTime_Stopwatch 
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Table 5-2: Parameters of "LHmiTime_Stopwatch" 

Name P type Data type Comment 

round IN Bool Lap trigger 

reset IN Bool Reset trigger 

enableReset OUT Bool Availability reset trigger 

total IN_OUT "LHmiTime_ 
typeRoundStopWatch" 

Total stop time 

round1 IN_OUT "LHmiTime_ 
typeRoundStopWatch" 

Lap time 1 

round2 IN_OUT "LHmiTime_ 
typeRoundStopWatch" 

Lap time 2 

round3 IN_OUT "LHmiTime_ 
typeRoundStopWatch" 

Lap time 3 
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Name P type Data type Comment 

round4 IN_OUT "LHmiTime_ 
typeRoundStopWatch" 

Lap time 4 

round5 IN_OUT "LHmiTime_ 
typeRoundStopWatch" 

Lap time 5 

start IN_OUT Bool Start trigger 

 

5.2 Integration into the user project 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiTime > 
Stopwatch" of the library. 

3. Drag the elements (Template, Screen, Tag table) to the corresponding folder of 
the operator panel. 

Figure 5-3 

 

Note 

Depending on the size of the HMI operator panel, it may be necessary to adapt 
the screen. 
If your HMI connection to the PLC is not called "HMI_Connection_1", update 
your HMI connection in the tag table. 

You must also synchronize the HMI tags again with the PLC tags. 

4. Drag the "btnStopwatch" button from the library to your screen. You open the 
tool with this button. 

5. Open the folder "Master copies > 01_PLC > 03_Tools > 01_Blocks > 
LHmiTime" of the library. 
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6. Drag the data block "LHmiTime_CommDB" to the "Program blocks" folder of 
your PLC. 

Figure 5-4 

 

All tags that are required for the stopwatch have the prefix "stopWatch". Delete 
all other tags from the data block if you do not need them. 

7. Open the folder "Types > 03_Tools > 01_Blocks > LHmiTime > Stopwatch" of 
the library. 

8. Drag the function block "LHmiTime_Stopwatch" to the "Program blocks" folder 
of your PLC. 

Figure 5-5 
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9. Call the function block "LHmiTime_Stopwatch" in your user program and 
interconnect the inputs and outputs with the corresponding tags of the 
communication DB. 

Figure 5-6 

 
 

10. Download the software to your operator panel and your PLC or start the 
simulation. 
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5.3 Operation  

1. Open the visualization on your operator panel or simulate it. 

2. Open the Tools overview and click on the "Stopwatch" button. 

3. Start the stopwatch with the "START" button.  

Figure 5-7 

 

4. Take a lap time by pressing the "NEW LAP" button.  

A new lap starts and the measured lap time is displayed under "Laps (5)". 

5. Stop the stopwatch with the "STOP" button. 

Reset the lap time with the "CLEAR" button. 
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6 Time functions – Timer 

6.1 General description 

You use the timer to have the system remind you of an event after a defined 
runtime has elapsed.  

By default, the timer offers five runtimes (1 min, 2 min, 5 min, 10 min, 15 min). You 
set the runtime by pressing the associated button. 

The PLC starts a timer with the specified runtime and triggers an alarm when this 
time has expired.  

In the status bar you can see when the timer has expired and acknowledge it. 

If you close the screen before the timer is triggered, the timer still remains active. 

 

Figure 6-1 

 

 

6.1.1 Hardware and software components 

The application example is valid for: 

• SIMATIC STEP 7 Basic / Professional V15.1 

• SIMATIC WinCC Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels,  
Mobile Panels 2nd Generation  

• SIMATIC WinCC RT Advanced V15.1 

• SIMATIC S7-1500 
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6.1.2 Function blocks used 

This section explains the functions of the function blocks used in the tool. 

FC "LGF_DTLtoString"  

The function block "LGF_DTLtoString" has been applied from the "Library with 
general functions (LGF) for STEP 7 (TIA Portal) and S7-1200 / S7-1500" library. 
This block converts a date component of the data type "DTL" to a character string 
of the format "String". 

The link to the entry page of the library is available in the document list under \3\. 

FB "LHmiTime_Timer" 

The function block "LHmiTime_Timer" starts a timer with the runtime "duration". 
When this runtime has expired, the function block sets an alarm status "elapsed" 
and returns the current system time "elapsedTime". 

 

Figure 6-2 LHmiTime_Timer 
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Table 6-1: Parameters of "LHmiTime_Timer" 

Name P type Data type Comment 

duration IN Time Timer, runtime 

reset IN Bool Timer, reset trigger 

elapsed OUT Bool Timer, trigger for pop-up screen 

elapsedTime OUT String Timer, time stamp for HMI 

secRemaining OUT Int Timer, remaining seconds 

minRemaining OUT Int Timer, remaining minutes 

start IN_OUT Bool Timer, Start/Stop trigger 
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6.2 Integration into the user project 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiTime > Timer" of 
the library. 

3. Drag the elements (Template, Screen, Tag table) to the corresponding folder of 
the operator panel. 

Figure 6-3 

 

Note 

Depending on the size of the HMI operator panel, it may be necessary to adapt 
the screen. 
If your HMI connection to the PLC is not called "HMI_Connection_1", update 
your HMI connection in the tag table. 

You must also synchronize the HMI tags again with the PLC tags. 

4. Drag the "btnTimer" button from the library to your screen. You open the tool 
with this button. 

5. Open the folder "Master copies > 01_PLC > 03_Tools > 01_Blocks > 
LHmiTime" of the library. 

6. Drag the data block "LHmiTime_CommDB" to the "Program blocks" folder of 
your PLC. 

Figure 6-4 
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All tags that are required for the "Timer" have the prefix "timer". Delete all other 
tags from the data block if you do not need them. 

7. Open the folder "Types > 03_Tools > 01_Blocks > LHmiTime > Timer" of the 
library. 

8. Drag the function blocks "LHmiTime_Timer" to the "Program blocks" folder of 
your PLC. 

Figure 6-5 

 

9. Call the function block "LHmiTime_Timer" in your user program and 
interconnect the inputs and outputs with the corresponding tags of the 
communication DB. 

Figure 6-6 

 

10. Download the software to your operator panel and your PLC or start the 
simulation. 
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6.3 Operation  

1. Open the visualization on your operator panel or simulate it. 

2. Open the Tools overview and click on the "Timer" button. 

3. Select the runtime and enter a reminder text. 

Start the stopwatch with the "START" button.  

Figure 6-7 

 

You stop and reset the timer with the "RESET" button. 

4. When the timer has expired, the screen with the timer is opened and the 
associated reminder text with a button to confirm it is shown in the status bar.  

5. Acknowledge the pending event alarm with the "OK" button. 
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7 Time functions – Time switch 

7.1 General description 

You use the time switch to execute a defined action at specified times. 

As an example, the application example shows you how to set an individual on and 
off time for each day of the week during runtime of the visualization. A status bit is 
set when the on time is reached; the status bit can be used to execute a defined 
action. 

The time switch shows all days of the week and highlights the current day in color. 

You can save the configuration of the on and off times in the file system or 
download it from the file system. 

 

Figure 7-1 

 

 

7.1.1 Hardware and software components 

The application example is valid for: 

• SIMATIC WinCC Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels,  
Mobile Panels 2nd Generation 

• SIMATIC WinCC RT Advanced V15.1 
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7.1.2 VBS scripts used 

The individual functions of the time switch are solved with the help of multiple 
scripts. You may be able to use these scripts for other areas of application. 

LHmiTime_vbsSaveToFileSystem 

Depending on the operating system, the script "LHmiTime_vbsSaveToFileSystem" 
saves the configuration file "LHmiTime_Timeswitch.txt" with the current on and off 
times to the file system. The storage path of the file is: 

• Panels: \flash\106226404_Tools\   

• WinCC RT Advanced: C:\106226404_Tools\  

 

Note If the folder and the file do not exist yet, they are now created. 
If the file already exists at the storage location, its content is overwritten. 

LHmiTime_vbsLoadFromFileSystem 

Depending on the operating system, the script 
"LHmiTime_vbsLoadFromFileSystem" reads the saved configuration file 
"LHmiTime_Timeswitch.txt " and writes it to HMI tags of the time switch. 

LHmiTime_vbsNextTime 

The script "LHmiTime_vbsNextTime" sets the on and off times for the current day. 

LHmiTime_vbsSetAll 

The script "LHmiTime_vbsSetAll" sets the on and off times for Tuesday – Sunday 
to the on and off time for Monday. 
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7.2 Integration into the user project 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiTime > 
TimeSwitch" of the library. 

3. Drag the elements (Template, Screens, Scripts, Tasks, Tag table) to the 
corresponding folder of the operator panel. 

Figure 7-2 

 

Note 

Depending on the size of the HMI operator panel, it may be necessary to adapt 
the screens. 
If your HMI connection to the PLC is not called "HMI_Connection_1", update 
your HMI connection in the tag table. 

You must also synchronize the HMI tags again with the PLC tags. 

 

4. Open the "LHmiTime_vbsLoadFromFileSystem" script at the "Set up" event of 
your start screen so that the events are loaded after a restart. 

5. Drag the "btnTimeSwitch" button from the library to your screen. You open the 
tool with this button. 

6. Connect an event of your choice that you want to execute in a time-controlled 
manner to the "Value change" event of the "LHmiTime_ResultTimeSwitch" tag.  
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7.3 Operation  

1. Download the visualization to your operator panel or simulate it. 

2. Open the Tools overview and click on the "Time switch" button. 

3. Set the on and off times for the current day and confirm the settings with the 
"CONFIRM" button. 

Figure 7-3 

3

 

Note 

When the on time has been reached, the status bit is set and the status 
indicator (RGB: 133, 164, 8) is highlighted in green. When the off time is 
activated, the bit is reset and the status indicator (RGB: 202, 51, 51) is 
highlighted in red. 

 

4. Export the current configuration with the "EXPORT" button. 

5. Change the on and off times. 

6. Import the saved configuration with the "IMPORT" button. 
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8 Time functions – World clocks 

8.1 General description 

You use the world clock to display clocks with different time zones on your HMI 
operator panel.  

VBS scripts calculate the time zones directly on the HMI operator panel.  

Four different clocks with different time zones are displayed in the application 
example. An extension to include additional time zones is possible at any time. 

• Reykjavik, Iceland (UTC + 0:00 h) 

• Los Angeles, USA (UTC – 8:00 h) 

• Nuremberg, Germany (UTC + 1:00 h) 

• New Delhi, India (UTC + 5:30 h) 

This tool does not depend on a PLC. The calculations are performed by the HMI 
operator panel. 

 

Figure 8-1 

 

 

8.1.1 Hardware and software components 

This application example is valid for: 

• SIMATIC WinCC Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels,  
Mobile Panels 2nd Generation 

• SIMATIC WinCC RT Advanced V15.1 
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8.1.2 Data types used 

This section explains the data types used by the tool. 

 

Data type "LHmiTime_typeWorldTimeClock" 

The data type "LHmiTime_typeWorldTimeClock" defines the parameters for the 
world clock. 

 

Table 8-1: Parameters of LHmiTime_typeWorldTimeClock 

Name Data type Comment 

clockZoneCityName WString City name, 12 characters 

clockZoneCityName WString Country name, 12 characters 

clockZoneTime DateTime Time of world clock 

clockZoneAmPm WString AM / PM display, 2 characters 

clockHours Int Hours of world clock 

clockMinutes Int Minutes of world clock 

 

8.1.3 VBS scripts used 

This section explains the functions of the scripts used in the tool. 

The individual functions of the world clock are solved in multiple scripts so that you 
can also use these for other functions, such as calculation of daylight saving / 
standard time. 

LHmiTime_vbsClockAmPm 

The script "LHmiTime_vbsClockAmPm" calculates for the English language 
whether the "Time" is to be displayed in AM and PM format. 

LHmiTime_vbsClock_HourHand 

The script "LHmiTime_vbsClockHourHand" calculates the time based on the 
position of the hour hand (0-60). 

LHmiTime_vbsDaylightSavingTime 

The script "LHmiTime_vbsDaylightSavingTime" calculates whether time is daylight 
saving or standard time. Start and end date as well as the respective time of the 
switch are required for calculation. To calculate the respective date, you can use 
the script "LHmiTime_vbsFindDayOfWeekOfMonth". 

LHmiTime_vbsFindDayOfWeekOfMonth 

The script "LHmiTime_vbsFindDayOfWeekOfMonth" calculates the first, second, 
third, fourth or last day of a week in a particular month based on the specified 
parameters. These parameters are required: 

• the current week (1-4 or 5 for the last) 

• the day of the week (1-7, starting with Sunday) 

• the month (1-12) 
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LHmiTime_vbsTimezoneDisZone 

The script "LHmiTime_vbsTimezoneDisZone" calculates the current time in a 
particular time zone using the UTC time and the difference between UTC time and 
the desired time zone.  

To do this, the script must be handed over: 

• The current UTC time (calculation via "LHmiTime_vbsTimezoneUTCTime") 

• Difference between UTC time and the time zone (in hours)  

• Information on daylight saving / standard time (0: Standard time, 1: Daylight 
saving time) 

LHmiTime_vbsTimezoneUTCTime 

The script "LHmiTime_vbsTimezoneUTCTime" uses the local time to calculate and 
the difference between local and UTC time to calculate the UTC time. These 
parameters are required: 

• Difference between local and UTC time (in hours) 

• Information on daylight saving / standard time (0: Standard time, 1: Daylight 
saving time). 

LHmiTime_vbsWorldTimeClock 

The script "LHmiTime_vbsWorldTimeClock" calculates the time of the individual 
time zones.  

Further information can be found in section 8.2.2. 
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8.2 Integration into the user project 

8.2.1 Using the world clocks 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiTime > 
WorldTimeClock" of the library. 

3. Drag the elements (Template, Screens, Scripts, Task, Tag table) to the 
corresponding folder of the operator panel. 

Figure 8-2 

 

Note 
Depending on the size of the HMI operator panel, it may be necessary to adapt 
the screens. 
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4. Drag the "btnWorldClocks" button from the library to your screen. You open the 
tool with this button. 

 

8.2.2 Adding new world clocks 

1. Open the tag table "LHmiTime_WorldClockTags". 

2. Add a new tag "LHmiTime_ClockNew" of the data type 
"LHmiTime_typeWorldTimeClock". 

Figure 8-3 

 

3. Open the screen in which you want to add the world clock. 

4. Drag and drop a new instance of the "LHmiTime_fpWorldTimeClock" faceplate 
from the project library. 

Figure 8-4 

 

5. Select the faceplate and open the block interface with "Properties > Interface". 
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6. Specify the design parameters (background color, text size, etc.) in the 
"Design" category.  
Connect the created tag for the world clock parameters to the "Values" 
property of the "parametersClock" category. 

Figure 8-5 

 

7. Open the script "LHmi_vbsWorldTimeClock". 
Copy one of the blocks (e.g. "LA") and insert it at the end of the script. 

8. Replace the tags in the copied block with the newly inserted tags. 

Figure 8-6 

 
Note 

Make sure that you do not change the tag 
"LHmiTime_ClockReykjavik.clockZoneTime". 

 

9. Change the zone name to your new zone name. 

Figure 8-7 
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10. Enter the values for the daylight saving time switchover of your time zone in 
"DateStart", "TimeStart", "DateEnd" and "TimeEnd" (parameters see  
section 8.1.3). 

Figure 8-8 

 

Note 

If there is no switchover to daylight saving time in your time zone, replace the 
lines with "DSTActive = 0" (see example "India"). 
 

11. For the second parameter of the function "LHmiTime_TimezoneDisZone", 
enter the difference of your time zone to the UTC time (in hours).  

Figure 8-9 

 

12. Call the script "LHmi_vbsWorldTimeClock" at the "Loaded" event of your 
screen. 

 

8.3 Operation  

1. Open the visualization on your operator panel or simulate it. 

2. Open the Tools overview and click on the "Worldclock" button. 

3. Use the page navigation on the left to switch between the individual regions. 

Figure 8-10 
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9 Data transfer – Chat function between 
operator panels 

9.1 General description 

You are working on an HMI device and would like to exchange information with the 
operator of a remote HMI device in real-time.  

You can exchange of data between SIMATIC HMI devices with the "SIMATIC HMI 
HTTP" communication driver. To show the latest information, alarms are generated 
and displayed in an alarm view. 

One HMI device is the server and the other the client in this scenario. 

 

Figure 9-1 

 

 

9.1.1 Hardware and software components 

The application example is valid for: 

• SIMATIC WinCC Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels,  
Mobile Panels 2nd Generation 

• SIMATIC WinCC RT Advanced V15.1 
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9.2 Integration into the user project 

1. Open your WinCC configuration. 

 

9.2.1 Chat server configuration 

2. Open the Runtime settings of the HMI device that you want to use as server 
with "Project navigation > Runtime settings". 

3. Under "Services", activate the "HTTP channel server" service.  

Figure 9-2 

 

4. Compile your project and load it to your HMI device. 
The web server with its HTTP service is started on the HMI device. 

5. Exit the ongoing runtime. 

6. Open the "WinCC Internet Settings". 

– Panels: "My Computer > Control panel > WinCC Internet Settings" 

– WinCC RT Advanced: "Control Panel > WinCC Runtime Advanced 
Internet" 

Figure 9-3 
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7. Select the "Web Server" tab and select the option "Authentication required". 
This option activates the password access to the web server. 

Figure 9-4 

 

8. Open the user administration with a click on the "User Administration" button. 

9. Create a new user with the "New" button. 

– User Name: Chat 

– Password: chat123 

– Confirm Password: chat123 

Figure 9-5 

 

 

Click "Apply" to confirm your entries. 

10. Select the user "Chat" and go to the "Authorizations" tab. 

Figure 9-6 
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11. Select the "RTCommunication" authorization and add it to the user with the 
"Add" button.  

Figure 9-7 

 

Close the window with the "X" button. 

12. Confirm the Note window to back up the authorizations and restart the web 
server with the "Yes" button. 

Figure 9-8 

      

 

 

9.2.2 Chat client configuration 

2. Open the Connections editor of the HMI device that you want to use as client 
with "Project navigation > Connections". 

3. Create a new HTTP connection. 

– Name: HmiConnectionChat 

– Communication driver: SIMATIC HMI HTTP 

4. Select the HTTP connection and change the communication settings. 

– Address: http:// <ip address chat server> 

– User Name: Chat 

– Password: chat123 

– Timeout: 10s 
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Figure 9-9 

 

 

 

9.2.3 Chat client and chat server configuration 

1. Open the editor for HMI alarms of the client operator panel via "Project 
navigation > HMI alarms". 

Go to the "Alarm classes" tab and create a new alarm class called "Chat". 

– Display name: Chat 

– Name: Chat 

– State machine: "Alarm without acknowledgment" 

– Background colors: Can be freely selected 

Figure 9-10 

 

Repeat step 1 for the HMI operator panel that you are using as server. 

2. Open the library with the tools (section 2.3). 

3. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiData > Chat" of 
the library. 
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4. Drag the elements (Template, Screen, Tag table) to the corresponding folder of 
the operator panels (server and client). 
 

Server 

– Template "TemplateGeneralStatusBar" 

– Screen "LHmiData_ChatServer" 

– Tag table "LHmiData_ChatServer" 
 

Client 

– Template "TemplateGeneralStatusBar" 

– Screen "LHmiData_ChatClient" 

– Tag table "LHmiData_ChatClient" 
 

Figure 9-11 

 

Note 
If you want to use a pop-up screen, the screen object groups 
"objGrpChatClient" and "objGrpChatServer" are available as an alternative. 
You drag and drop the screen objects to a pop-up screen of your choice. 

Open the tag table "LHmiData_ChatClient", select the tag 
"LHmiData_newMessage" and add an event for calling your pop-up screen 
under "Properties > Event > Value change". 

Repeat this step for the server operator panel (tag table:  
"LHmiData_ChatServer"). 



9 Data transfer – Chat function between operator panels 

 

Toolbox für HMI-Projekte 
Entry ID: 106226404,    V5.0,    02/2019   69 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

9.3 Operation 

1. Download the example project to your HMI operator panels (server: WinCC 
RT Advanced, client: TP900 Comfort) and start both runtimes.  

If you only have access to one HMI operator panel, simulate the other HMI 
operator panel as an alternative. 

2. Open the Tools overview of the TP900 Comfort and click on the "Chat" button. 

3. Write a message of your choice. Confirm the entry with "Enter". In WinCC RT 
Advanced, the chat window opens with your message. 

4. Reply to the TP900 Comfort with a message of your choice. The message is 
displayed in the chat window of the panel. 

Figure 9-12 

 

5. Change the screen in WinCC RT Advanced. The status bar of the chat window 
in the TP900 Comfort is highlighted in yellow. If the chat window is open in 
both operator panels, the status bar is highlighted in green. 

Figure 9-13 
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10 Data transfer - Barcode 

10.1 General description 

To display a barcode using a SIMATIC HMI Panel / PC station with 
WinCC RT Advanced or to print out this barcode, you must install an appropriate 
font on your programming device.  

You can find numerous providers of these fonts on the Internet. The "Code-39-
Logitogo Version V1.0 (with width check)" font was used for the application 
example.  
You can find additional information on this in the document list under \11\. 

A screen with multiple text boxes is used to enter data for a delivery note. For 
illustration purposes, the barcodes of the previously entered texts are displayed. 
The entered data can be output on a printer as a barcode in form of a "log printout". 

 

Figure 10-1 
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Figure 10-2 

 

 

The barcode is created by direct input using a "TrueType font". Depending on the 
respective barcode type, a start and stop character is expected. This is the 
"*"character for the font used in the example project.  

For detailed information on the design of the different barcode fonts, please refer to 
the appropriate font documentation. 

  

10.1.1 Hardware and software components 

The application example is valid for 

• SIMATIC WinCC Basic / Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels,  
Mobile Panels 2nd Generation 

• SIMATIC WinCC RT Advanced V15.1 

 

10.1.2 VBS scripts used 

This section explains the functions of the scripts used in the tool. 

"LHmiData_AddStartStopSign" 

The script "LHmiData_AddStartStopSign" adds a "*" as start and stop character to 
the entered string tags and saves this string in the HMI tag for the barcode. 
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10.2 Installing the barcode font 

10.2.1 Installation in Windows 

There are three options to install the font in Windows.  

Download the barcode font from the homepage of a manufacturer of your choice. 

 

Note Close all instances of the TIA Portal prior to the installation.  

If an instance of the TIA Portal was open during the installation of the font, close 
the TIA Portal and then restart it. 

Option 1 

1. Open the file with the barcode font by double clicking it. The font preview 
opens. 

2. Click "Install".  

Figure 10-3 

 

Note 
You need to have the required administrator rights to do this. 

 

Option 2 

1. Open the context menu of the barcode font and install the font with "Install". 

Figure 10-4 

 

Note 
You need to have the required administrator rights to do this. 
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Option 3 

1. Select the file for the barcode font and copy the file using the key combination 
<Ctrl> + <C>. 

2. Open the "Fonts" folder in the Control Panel. 

3. Add the "*.ttf" file of the font with the key combination <Ctrl> + <V>. 

 

10.2.2 Installation on Basic / Comfort Panels 

Automatic transfer by downloading the configuration 

The font is transferred to the panel along with the project and therefore must not be 
installed on the panel manually. The project contains the necessary data during 
download to the operator panel. 

The font is not saved in the font folder of the HMI operator panel. This means that 
the font is not recognized on the HMI operator panel outside of Runtime. 

Manual installation (optional) 

If you want to use the font outside of Runtime (RT), for example, display a Word file 
with characters of this font on the operator panel, install the font manually. 

1. Copy the file of the barcode font to a storage medium of your choice and 
connect it with your HMI operator panel. 

2. Open the Explorer via "Desktop > My Computer". 

3. Go to your storage medium and copy the barcode font file. 

4. Open the "Windows > Fonts" folder. 

5. Add the barcode font file to the "Fonts" folder. 

 

Note The installed font is only available for a few specific applications.  

You cannot change the system font for panels. 
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10.2.3 Integrating a font into your project 

Note When you configure a PC station with SIMATIC WinCC RT Advanced, you do 
not have to integrate the font. You only have to install the font on the operating 
system. All installed fonts of the Windows operating system are available for the 
configuration. 

 

To use the barcode font, integrate it as configured font into your HMI project. 

1. Open the folder of your operator panel in the project tree. 

2. Open the "Runtime settings" with a double-click. 

3. Select "Language & font". 

4. Select the cell under "Configured font 1". 

5. Click on the selection icon "[…]" and select the barcode font from the fonts 
installed on the operating system.  

6. If necessary, apply the settings for additional configured languages. 

7. Restart the TIA Portal and reopen your project. 

Figure 10-5 

 

Note 
With Basic Panels you can configure your own "Configured font 1" in addition to 
the system font. 

With Comfort Panels you can configure up to two separate fonts "Configured font 
1" and "Configured font 2" next to the system font. 

 

10.2.4 Using a font 

Setting the font, font style and font size 

You have to manually customize the font, as well as associated font style and font 
size for basic objects and elements. 

1. Select a basic object. 

2. Click on "Properties > Text format". 

3. In "Format > Font", click the "…" button. 

4. Select the barcode font and set "Font style" and "Size" as desired. 

5. Click on "OK". 
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10.3 Integration into the user project 

Note The correct installation of the barcode font on your panel/your PC station, as well 
as the integration into your WinCC project is a prerequisite for the integration. To 
do this, follow the description from chapter 10.2. 

 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiData> Barcode" 
of the library. 

3. Drag the elements (Template, Screen, Script, Tag table, Log) to the 
corresponding folder of the operator panel. 

Figure 10-6 

 

Note 

Depending on the size of the HMI operator panel, it may be necessary to adapt 
the screens. 
 

4. Drag the "btnBarcode" button from the library to your screen. You open the tool 
with this button. 

5. Check the integration into your barcode font under "Project navigation > 
Runtime Settings > Language & fonts" (chapter 10.2.3). 

6. Open the "LHmiData_Barcode" screen with "Project navigation > Screens". 

7. Select the I/O fields "ioBarcodeDeliveryNo" and "ioBarcodeArticleNo" and open 
the settings for the text format. 
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8. Select the barcode font as text format using the menu bar of the screen editor 
and a suitable size. 

Figure 10-7 

 

9. Open the "LHmiData_ReportBarcode" report with ("Project navigation > 
Reports"). 

10. Select the I/O fields "ioBarcodeDeliveryNo" and "ioBarcodeArticleNo" and open 
the settings for the text format. 

11. Select the barcode font as text format using the menu bar of the screen editor 
and a suitable size. 

Figure 10-8 
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10.4 Operation 

Note Requirement for operation is the correct integration into the user project. To do 
this, follow the description from chapter 10.3. 

 

1. Open the visualization on your operator panel or simulate it. 

2. Open the Tools overview and click on the "Barcode" button. 

3. Enter a delivery note number, an article name and the article number. Confirm 
your entry with "Enter". The I/O fields show the associated barcodes. 

Figure 10-9 

 

4. Print the report with the current parameters by pressing the "PRINT" button. A 
dialog window for saving the report appears. 

Note 

Specify a default printer beforehand. Otherwise, you will see an error message. 
 

5. Save the report at a storage location of your choice. 
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11 Data transfer – QR Codes 

11.1 General description 

It is often useful to transfer information from operator panels or controllers to a cell 
phone or tablet PC. 

An option should be used without having to integrate the cell phone or tablet PC 
into the automation network. 

The Comfort Panel generates a QR code from the information to be transferred. 
The QR code can be read and interpreted by the cell phone or tablet PC. 

 

Figure 11-1 

 

 

11.1.1 Hardware and software components 

The application example is valid for: 

• SIMATIC WinCC Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels,  
Mobile Panels 2nd Generation 

• SIMATIC WinCC RT Advanced V15.1 
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11.1.2 Basics 

Structure of the QR code used 

Table 11-1 

QR code (marked with color) Meaning 

 

 Encoding type 

This QR code uses eight bit per character. 
This makes it possible to represent most 
ASCII characters. The encoding type is 
"0100" in binary format.  The property 
cannot be changed. 

 Length 

Specifies the number of characters used in 
the QR code. This code always contains 17 
characters. (If fewer characters are used, 
the script will add the missing characters.) 

 Data blocks 

The data blocks contain the encoded 
information. Based on the ASCII table, each 
character is converted into a byte and 
encoded in these blocks. 

 Error blocks 

The error blocks contain the error number 
of the "Reed-Solomon" algorithm \8\. 

 Formatting 

The formatting blocks contain information 
on the QR code structure. This application 
uses a simple structure. 

(Error level: L 
Mask pattern: i%2 = 0 
Meaning: The black blocks change the 
value depending whether the number is 
even or odd.) 

 

11.1.3 VBS scripts used 

This section explains the functions of the scripts used in the tool. 

"LHmiData_vbsGenerateQRCode" 

Depending on the defaults or the settings you have made, described in greater 
detail  
in chapter 11.2, the script calculates the binary code of the tag to be represented 
"LHmiData_textForQRCode".  
In addition, other information (information on error correction) is converted 
according to the "Reed-Solomon" algorithm (document list under \8\) The result of 
the script is displayed using the "visibility" property of the individual elements 
(squares) of the QR code. 
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11.2 Integration into the user project 

1. Open your WinCC configuration and the library with the tool (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiData > QRCode" 
of the library. 

3. Drag the elements (Template, Screens, Script, Tag table) to the corresponding 
folder of the operator panel.  

The "VariousResolutions" folder contains various resolutions of the QR code. 
Alternatively, you can also use a different resolution. Simply drag and drop the 
grouping to your screen selection.  

Figure 11-2 

 

Note 

Depending on the size of the HMI operator panel, it may be necessary to adapt 
the screens. 
 

4. Drag the "btnQRCode" button from the library to your screen. You open the 
tool with this button. 

5. Open the VBS script "LHmiData_vbsGenerateQRCode".  

6. In line 34 of the script, check the name of the screen on which you have used 
the QR code and adapt it, if necessary. 
(In the example: "LHmiData_QRCodeExample") 

Figure 11-3 
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7. In line 54 of the script, check the name of the tag that you want to convert into 
the QR code and adapt it, if necessary (in the example: " 
LHmiData_textForQRCode "). 

Figure 11-4 

 

8. Open the "LHmiData_QRCodeExample" screen. 

9. Connect the script "LHmiData_vbsGenerateQRCode" to the "Press" event of 
the "GENERATE" button.  

Figure 11-5 

 

 

11.3 Operation 

1. Download the visualization on your operator panel or simulate it. 

2. Open the Tools overview and click on the "QR code" button. 

3. Enter a random text into the I/O field. The text is limited to 17 characters.  

Then press the "GENERATE" button. The QR code is generated. 

Figure 11-6 

 

 

4. Use the page navigation on the left to view the possible resolutions of the QR 
code. These are not connected to the tag. 

 

 



12 Data transfer – Sending Emails 

 

Toolbox für HMI-Projekte 
Entry ID: 106226404,    V5.0,    02/2019   82 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

12 Data transfer – Sending Emails 

12.1 General description 

As not all machines of a plant are permanently monitored by staff, it is often not 
possible to promptly react to pending alarms on the operator panel. This problem is 
to be solved by an automatic email notification. 

With this tool you integrate automatic emails for a three-shift system as well as 
manual emails for Comfort Panels. With automatic emails, the employee in charge 
is notified directly via email as soon as a specific analog alarm occurs.  

The address of the recipient is determined by the shift schedule in this case. At the 
time of a shift change, the active email takes over the set email of the active shift 
via the scheduler. 

An email is automatically sent in case of a specific analog alarm with this tool. As 
an alternative to the individual alarm, you can also define an alarm class for 
sending emails. If an alarm of this alarm class occurs, an alarm is sent to the 
respective recipient. In this case, you will not need to activate the "Send email" 
function multiple times. 

 

Figure 12-1 
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Figure 12-2 

 

Email addresses are reliably backed up using recipe management in the operator 
panel so that they are still available after a restart. 

 

Figure 12-3 

 

 

12.1.1 Hardware and software components 

This application example is valid for: 

• SIMATIC WinCC Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels,  
Mobile Panels 2nd Generation 

• SIMATIC WinCC RT Advanced V15.1 
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12.2 Basics 

12.2.1 SMTP service and server 

This tool uses the SMTP service (SMTP: Simple Mail Transfer Protocol) of the 
operator panel.  

The operator panel establishes an SMTP connection to a SMTP server in the 
network or the Internet with this service. The SMTP server, or email server, is a 
server that sends emails. After the connection has been established, the operator 
panel transfers the recipient address, subject line and text content of the email to 
the server. 

You specify the SMTP communication settings for the service in the Runtime 
settings in the operator panel. You can find these settings under "Project tree > 
Runtime settings > Services". 

Figure 12-4 

 

 

Table 12-1 

Field Explanation 

Server name SMTP server of the email service provider or your own email 
server. 

Please note: When using a Comfort Panel, the SMTP server can 
only be specified as a computer name or fully qualified domain 
name (FQDN); it cannot be entered as an IP address. 

Port SMTP server port used for sending email. 

Sender name This plain text name is entered as the sender of the email and can 
be defined as required; for example, "Hall1", "Panel123", etc. 

Email address Email sender address 

Log in Use the login data you defined when you created the email account. 

Password Use the password you defined when you created the email account. 

Secure connection 
required (SSL) 

Use of the SSL protocol (see below) 

 

The information relates to the email sender. You can use any provider for the 
recipient address(es). 
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12.2.2 Encrypted message transmission using SSL 

Unencrypted messages are not considered as secure because they can be read by 
third parties. For this reason, most SMTP servers accept requests for sending 
emails only if these requests are processed using the encrypted SSL protocol 
("Secure Sockets Layer"). 

To enable SSL, proceed as follows: 

1. In the dialog of Figure 12-4, check "Secure connection required (SSL)". 

2. Change the value for "Port" to the port reserved for SMTP by your provider. 

Most SSL servers use port 587 for SSL transmission. If sending emails with this 
port fail, consult your email service provider for the correct settings.  

 

12.2.3 Verifying the correct port for sending email 

If you are not sure whether your provider supports SSL or communicates via port 
587, perform the following steps on a PC connected to the Internet via the same 
subnet as your operator panel: 

1. Open the Windows Command Prompt. 

2. Enter the command line "telnet [SMTP server name] 587". (Replace "[SMTP 
server name]" with the actual server name.) 

Note 

The "Telnet" tool is not enabled by default on all Windows installations. If the 
command is not known to your command prompt, use "Control Panel > 
Programs and Features > Turn Windows features on or off" to enable Telnet in 
Windows 7. 
On other Windows versions, the path may differ slightly. 

 

3. If a message appears that a connection cannot be established, port 587 of 
your server is blocked. 

In this case, change the port to the value specified by your email service provider 
or use a different email service provider. 

 

Note If your provider does not support SSL yet, port 25 is used by default for sending 
emails. If this is the case, set "Port" to "25" as shown in Figure 12-4 and uncheck 
"Secure connection required (SSL)". 
Please note your emails are transmitted unencrypted in this case. 

 

12.2.4 Settings on the HMI operator panel 

The operator panel must be configured for connection to the Internet. 

Follow the device manual instructions (for Comfort Panels, see manual in the 
document list \5\ for correct setting of the parameters). 

Make sure that the panel network access is not restricted by domain policies or 
firewalls. If necessary, contact your domain administrator. 
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12.2.5 Forwarding emails as SMS text messages 

General 

Various mobile network operators offer a service that assigns an email address to 
a cell phone number of their network. Emails sent to this address are then 
converted to SMS text messages and forwarded to the mobile device in this format. 
This allows you to receive emails on a cell phone or smartphone  
without having an email client installed. 

 

Note The maximum length of an SMS text message is 160 characters as always. 
Longer emails are normally truncated by the provider. 

Enabling and disabling notification by SMS text message 

For an email to be converted into an SMS text message, the appropriate service 
must be signed up for with the mobile network operator. Using the example of T-
Mobile, the following sections describe how to do this.  

• Enabling reception of email with a provider: 
Send an SMS text message with the text "OPEN" to the T-Mobile speed dial 
number 8000. This opens your T-Mobile number for email reception. 
And the email address assigned to your cell phone is: 
T-Mobile phone number (incl. area code)@t-mobile-sms.de 
e.g. 017100000000@t-mobile-sms.de. 

• Disabling email reception: 
If you no longer want to receive emails, send an SMS text message with the 
text "CLOSE" to the T-Mobile speed dial number 8000. 

The above steps may be different for other mobile network operators. Changes on 
the HMI operator panel are not necessary. 

Other mobile network operators 

The following table lists a selection of providers offering SMS notification services. 
This list does not claim to be complete. 

Table 12-2 lists: 

• The keywords for the activation/deactivation message of the notification 
service, 

• the speed dial number to which the activation/deactivation message has to be 
sent, 

• the email address from which the received messages are forwarded as SMS 
text messages (replace the “[No]” with the appropriate cell phone number). 

• the individual providers’ websites 

 

Table 12-2 

 Vodafone O2 

Start/end of service OPEN / CLOSE +START / STOP 

Speed dial 3400 6245 

Email address [No]@vodafone-sms.de [No]@o2online.de 

Website http://www.vodafone.de http://www.o2online.de 

For more detailed information, please contact the respective provider. and obtain 
information on the "Enable cell phone for receiving email from the Internet" 
function. 

mailto:017100000000@t-mobile-sms.de
http://www.vodafone.de/
http://www.o2online.de/
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12.3 VBS scripts used 

This section explains the functions of the scripts used in the tool. 

LHmiData_vbsReadSavedValues 

The script "LHmiData_vbsReadSavedValues" restores the last saved settings of 
the shift schedule. To do this, the script reads the content of the 
"LHmiData_ShiftAddressesTimes.txt" file and writes it to the associated tags. 

LHmiData_vbsSendEmailMan 

This script is used for sending an email manually. The script reads the entered 
recipient address as well as subject and text and sends the email via SMTP 
service. 

LHmiData_vbsStartUp 

When the start screen is opened for the first time, this script will be run once. It is 
used for saving and reading the email addresses for the shift schedule and the 
start times of the shifts.  

If the file does not exist yet, the script creates the 
"LHmiData_ShiftAddressesTimes.txt" file with start values for the shift times and 
addresses.  

LHmiData_vbsWriteCurrentValues 

The script saves the current settings of the shift schedule in the 
"LHmiData_ShiftAddressesTimes.txt" file. 

LHmiData_vbsTransferAddressFromDirectory 

This script changes the email address of the selected shift time. It replaces the 
email address of the shift time by the one selected from the recipe.  

The emails are saved in a recipe as data records. You can expand the recipe by 
any number (max. 5000) of new emails.  

 

Note The configuration of the file system differs, depending on the operating system 
(Windows / Windows CE) of your HMI operator panel.  

As a result, the storage of the "LHmiData_ShiftAddressesTimes.txt" file is also 
different. 

• Panels path: \flash\106226404_Tools\ 

• WinCC RT Advanced path: C:\106226404_Tools\ 

 

The same is the case for the "LHmiData_recipesEmails" recipe that saves the 
email addresses as data records. 

• Panels path: \flash\106226404_Tools\Recipes 

• WinCC RT Advanced path: C:\106226404_Tools\Recipes 
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12.4 Integration into the user project 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiData > Chat" of 
the library. 

Figure 12-5 

 

3. Drag the elements (Template, Screens, Scripts, Tag table, Tasks, Recipe) to 
the corresponding folder of the operator panel.  

Note 

Depending on the size of the HMI operator panel, it may be necessary to adapt 
the screens. 
 

4. Drag the "btnEmail" button from the library to your screen. You open the tool 
with this button. 
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5. Open the "LHmiData_EmailAutoShiftsSettings" screen. Add the "StartUp" 
script for the "Loaded" event of the screen.  

Alternatively, you can also connect the script to the "Loaded" event of the start 
screen. 

Figure 12-6 

 

6. Open the Runtime settings of your HMI operator panel. 

7. Under "Services" enter your SMTP communication data (see chapter 12.2.4) 

Alternatively, you can make the SMTP settings in the panel control panel. 

Figure 12-7 

 

8. Open the recipe editor with "Project navigation >Recipes". 

9. Change the path for the recipe "LHmiData_recipesEmails" depending on the 
operator panel used. 

– WinCC RT Advanced: C:\106226404_Tools\Recipes 

– Panels:  \flash\106226404_Tools\Recipes 

Figure 12-8 

 

10. Select the recipe and open the editor for the data records above the Data 
records tab. 

Change the email addresses for the shifts to email addresses of your choice or 
use "<Hinzufügen>" to add additional email addresses for the address book. 

Figure 12-9 

 

11. Open the "LHmiData_EmailDirectory" screen. 

12. Select the Save button and open the results of the button. 
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Adjust the path to your operator panel for the "File name" transfer parameter of 
the "ExportDataRecords" system function. 

– WinCC RT Advanced: C:\106226404_Tools\Recipes 

– Panels:  \flash\106226404_Tools\Recipes 

Figure 12-10

 

13. Repeat step 12, the Load button and the "ImportDataRecords" system 
function. 

Figure 12-11
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12.5 Operation 

Note A requirement for these chapters is the correct configuration of the SMTP 
communication settings and accessibility of the SMTP server via the panel / 
WinCC RT Advanced.  

Make sure that all requirements are met before you download the example 
project. 

 

1. Open the visualization on your operator panel or simulate it. 

2. Open the Tools overview and click on the "Chat" button. 

3. Switch to the settings of the late shift with the "Late" button. Set the time when 
the late shift starts. The time for the shift end is automatically the start time of 
the next shift. 

Press the "OPEN" button to open the email address book. 

Figure 12-12 
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Select an address from your address book and confirm the selection with the 
"APPLY" button.The selected email address is added to the shift settings. 

In the status bar you can see the email address that is currently used. 

Figure 12-13 

2 31

4

5

 

Note 

Using the buttons of the recipe view, you can add new data records  
(email addresses) (1), save them (2) and delete existing ones again (3). 

You use the Save button (4) to export the data records to your operator panel. 
You use the Load button (5) to import the data records saved on the operator 
panel to your operator panel. 
 

4. Go to the general shift settings via the "Settings" tab.  
Trigger the email alarm with the Alarm button. 

Figure 12-14 

1

2

 

Note 

You use the Save button (1) to save the settings of the individual shifts in the 
"LHmiData_ShiftAddressesTimes.txt" file to your operator panel. You use the 
Load button (2) to import the settings saved on the operator panel. 
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5. Click the "Send man. email - Editor" button in the page navigation on the left. 

Figure 12-15 

 
 

6. Add an email recipient with the "TO…" button. The email address book opens 
as with "Send auto. email". 

Enter a subject and an email text. 

Figure 12-16 

 
 

7. Send the email with the "SEND" button. 
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13 Data transfer – Automatic backup of files 

13.1 General description 

13.1.1 Description 

With the aid of automatic backup, your files (e.g., archives) are backed up to any 
location (e.g., a USB flash drive, network folder, etc.) at configurable intervals. 

 

Figure 13-1 

 

 

13.1.2 Hardware and software components 

This application example is valid for: 

• SIMATIC WinCC Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels, Mobile 
Panels 2nd Generation 

• SIMATIC WinCC RT Advanced V15.1 

 

13.1.3 VBS scripts used 

This section explains the functions of the scripts used in the tool. 

LHmiData_vbsFcCalculateNextExecute 

The "LHmiData_vbsFcCalculateNextExecute" script calculates the time for the next 
automatic backup, based on the set time interval. 

LHmiData_vbsFcCopyFiles 

The "LHmiData_vbsFcCopyFiles" script copies the files selected together with date 
and time stamp to the file path selected. 
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LHmiData_vbsFcFileSelectCopyFiles 

The "LHmiData_vbsFcFileSelectCopyFiles" script writes the paths of the files to the 
copied into the associated HMI tags. 

LHmiData_vbsFcInitializeTime 

The "LHmiData_vbsFcInitializeTime" script reads the current time and writes it as 
default value for the backup time. 

LHmiData_vbsFcPreviousFolder 

The "LHmiData_vbsFcPreviousFolder" script opens the higher-level folder of the 
currently selected folder and shows it as a table. 

LHmiData_vbsFcReadFilesOfFolder 

The "LHmiData_vbsFcReadFilesOfFolder " script reads the files from the specified 
path and shows them as a table. 

LHmiData_vbsFcSearch 

The "LHmiData_vbsFcSearch" script searches for the specified file/folder in the 
current path. 

LHmiData_vbsFcShowFile 

The "LHmiData_vbsFcShowFile" script opens the selected folder/file. 

LHmiData_vbsFcWriteFilePropertiesToTags 

The "LHmiData_vbsFcWriteFilePropertiesToTags" script writes the properties of 
the selected folder/file to the associated HMI tags. 
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13.2 Integration into the user project 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiData > 
AutoBackup" of the library. 

3. Drag the elements (Template, Screens, Scripts, Tag table, Task) to the 
corresponding folder of the operator panel. 

Figure 13-2 

 

Note 

Depending on the size of the HMI operator panel, it may be necessary to adapt 
the screens. 
 

4. Drag the "btnAutoBackup" button from the library to your screen. You open the 
tool with this button.  
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5. Open the "LHmiData_FcNextBackup" screen. Add the following scripts for the 
"Loaded" event of the screen: 

– LHmiData_vbsInitializeTime,  

– LHmiData_vbsFcReadFilesOfFolder, folderpar: LHmiData_FcFolder (HMI 
tag) 

– LHmiData_vbsFcWriteFilePropertiesToTags  
index: LHmiData_FcIndex (HMI tag) 
(Alternatively, you can enter your own path that starts the File Explorer.) 

You can also connect the scripts to the "Loaded" event of your start screen. 

Figure 13-3 

 

  



13 Data transfer – Automatic backup of files 

 

Toolbox für HMI-Projekte 
Entry ID: 106226404,    V5.0,    02/2019   98 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

13.3 Operation 

1. Download the visualization on your operator panel or simulate it. 

2. Open the Tools overview and click on the "Auto. Backup" button. 

3. Enter the interval and the start time for the automatic backup. 

Confirm the entry with the "APPLY" button. 

Figure 13-4 

1

2

 

 

The date and time of the next backup is displayed in the "Next backup" (1) 
button. In the status bar (2) you can see the date and time of the last backup. 
 

Click the "Selected Files" button in the page navigation on the left. Open the 
File Explorer with the Edit button. The File Explorer opens. 

Figure 13-5 
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4. Select a file of your choice and confirm the selection with "OK". 

Figure 13-6 

1 2

3

4 5

6
 

Note 

You use the Back button (1) to move up one folder level and the Folder button 
(2) to move down one folder level.  

You use the Find button (3) to filter for the filter string of the I/O field. Only 
entries that contain this text segment are still displayed in the table.  

The display area of the File Explorer is limited. Use the scroll bar (4) to view 
more entries. 

Press the "x" (5) button and close the File Explorer without applying a file. 

The status of the File Explorer is shown in the status bar (6). 
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14 Mathematical functions – Calculator 

14.1 General description 

The calculator allows you to make small calculations of individual process 
variables. It provides simple, mathematical arithmetic operations (such as "+" and 
"-", for example). 

The arithmetic operations are made by a VBS script within the faceplate. 

The calculator is independent from the controller and mapped by a faceplate. The 
operator panel is realized as an HMI faceplate and offers you the option to 
individually customize the labeling of the buttons. This makes it possible to flexibly 
use and call the calculator. 

For further processing of the value, use the "LHmiTime_calculation" tag of the 
"LReal" data type. 

 

Figure 14-1 

 

 

14.1.1 Hardware and software components 

This application example is valid for: 

• SIMATIC WinCC Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels, Mobile 
Panels 2nd Generation 

• SIMATIC WinCC RT Advanced V15.1 



14 Mathematical functions – Calculator 

 

Toolbox für HMI-Projekte 
Entry ID: 106226404,    V5.0,    02/2019   101 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

14.2 Integration into the user project 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiMath> 
Calculator" of the library. 

3. Drag the elements (Template, Screen, Tag table) to the corresponding folder of 
the operator panel. 

Figure 14-2 

 

Note on figure 

Depending on the size of the HMI operator panel, it may be necessary to adapt 
the screens. 
If your HMI connection to the PLC is not called "HMI_Connection_1", update 
your HMI connection in the tag table. 

You must also synchronize the HMI tags again with the PLC tags. 

Note on language 

Check the current setting for the decimal separator in "Control Panel > Region 
and Language > Formats > Additional settings > Decimal symbol". Depending 
on this setting, you use different faceplates in the screen. 

Decimal separator ",": "LHmiMath_fpCalculatorDE" 

Decimal separator ".": "LHmiMath_fpCalculatorEN" 

 

4. Drag the "btnCalculator" button from the library to your screen. You open the 
tool with this button. 

5. Open the "LHmiMath_Calculator" screen. 

6. Select the faceplate for the calculator and open the block interface with 
"Properties > Interface". 
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7. Specify the design parameters (background color, text size, etc.) in the 
"Design" category.  
Connect the tag "LHmiMath_calculation" for the result to the "calculation" 
property of the "Values" category. 

Figure 14-3 

 

14.3 Operation 

1. Open the visualization on your operator panel or simulate it. 

2. Open the Tools overview and click on the "Calculator" button. 

3. Operate the calculator as you would any standard calculator. 
Enter an arithmetic operation of your choice and have the result displayed in 
the display with the "=" button. 

 

Figure 14-4 
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15 Mathematical functions – Unit converter 

15.1 General description 

The unit converter is used to quickly and easily switch between different unit 
systems when displaying process data. While the data can be displayed and 
entered in different systems, the user program in the CPU will not be affected by 
the switchover between the unit systems. Instead, all HMI data is to be 
automatically converted to the CPU’s system of units. 

The example project contains two faceplates for unit conversion between imperial 
and SI system: 

• Temperature: °Celsius (°C)  °Fahrenheit (°F) 

• Length: Millimeters (mm)  inches (in) 

 

Figure 15-1 

 

 

15.1.1 Hardware and software components 

This application example is valid for: 

• SIMATIC WinCC Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels,  
Mobile Panels 2nd Generation 

• SIMATIC WinCC RT Advanced V15.1 
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15.2 Integration into the user project 

15.2.1 Using the unit converter 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiMath> 
UnitSwitch" of the library. 

3. Drag the elements (Template, Screen, Tag table) to the corresponding folder of 
the operator panel. 

Figure 15-2 

 

Note on figure 

Depending on the size of the HMI operator panel, it may be necessary to adapt 
the screens. 
If your HMI connection to the PLC is not called "HMI_Connection_1", update 
your HMI connection in the tag table. 

You must also synchronize the HMI tags again with the PLC tags. 

4. Drag the "btnUnitSwitch" button from the library to your screen. You open the 
tool with this button. 

5. Open the "LHmiMath_UnitSwitch" screen. 

6. Select the faceplate for the "Temperature" unit converter and open the block 
interface with "Properties > Interface". 

7. Specify the style for the I/O fields of the faceplate with the "Design" category 
and activate the faceplate using the option button. 
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8. Connect the associated tags from the "LHmiMath_UnitSwitch" tag table to the 
properties of the "Values" category. 

 

Note 
The use of two HMI tags for the temperature is for demonstration purposes 
only. In practice, you would use only one tag in the process. 

 

9. Repeat steps 6-7 for the faceplate of the "Length" unit converter. 

Figure 15-3 

 

10. Select the faceplate for the switch and open the block interface with "Properties 
> Interface". 

Connect the "LHmiMath_UnitSystem" tag to the "Value" property of the 
"Properties_Faceplate" category. 

Figure 15-4 

 

 
You control the conversion in the faceplates with the tag value. 

– 0: Metric unit system 

– 1: Imperial unit system 
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15.2.2 Configuring additional unit converters 

1. Open the "Project library" pane and duplicate the "Length_Conversion" 
faceplate. 

Figure 15-5 

 

2. Name the faceplate (for example, "Pressure_Conversion"). 

If necessary, adjust the version and enter a comment for the version. 

Figure 15-6 

 
The type is stored in the project library. 
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3. Open the faceplate in edit mode. 

Figure 15-7 

 

4. Select the "Properties" tab in the configuration area and open the view of the 
interface parameters in the right screen area with the black arrow. 

In the Inspector window under "Properties > General", adjust the names of the 
properties of the "Values" category as well as the names of the two I/O fields.  

Figure 15-8 

 

 

5. Select the "Scripts" tab in the configuration area.  

Select a script and press "F2". Rename the script. 
Enter the conversion formulas for the unit systems.  

Figure 15-9 

 

Repeat this step for the other script. 
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6. Select an I/O field. Specify the unit of the value under "Properties > 
Appearance > Unit".  

Figure 15-10 

 

Repeat this step for the second I/O field. 

7. Release the faceplate. 

Figure 15-11 
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15.3 Operation 

1. Open the visualization on your operator panel or simulate it. 

2. Open the Tools overview and click on the "Unit converter" button. 

3. Select a value of your choice for temperature and length. 

Figure 15-12 

 

 

4. Confirm the "Enable" switch.  
The I/O fields show the converted temperature and length values. 

Figure 15-13 
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16 Simplified operation – On-screen 
keyboards 

16.1 General description 

The standard on-screen keyboard in control panels cannot be resized and is only 
available in a single keyboard layout (English). You can create proprietary 
keyboards which fit your space and language requirements using faceplates. 

The on-screen keyboard tool provides five faceplates with different keyboards in 
the language versions "German (Germany)" and "English (USA)". 

 

Figure 16-1: QWERTY keyboard  

 

 

Figure 16-2: Numeric keypad 
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Figure 16-3: Cyrillic keypad 

 

 

Figure 16-4: AZERTY keyboard 

 

 

Figure 16-5: Language-dependent keyboard (German (Germany), English (USA)) 

 

 

16.1.1 Hardware and software components 

This application example is valid for: 

• SIMATIC WinCC Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels, Mobile 
Panels 2nd Generation 

• SIMATIC WinCC RT Advanced V15.1 
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16.1.2 VBS scripts used 

This section explains the functions of the scripts used in the tool. 

LHmiOper_vbsOpenAZERTYKeyboard 

The "LHmiOper_vbsOpenAZERTYKeyboard" script opens the 
"LHmiOper_popupAZERTYKeyboard" pop-up screen. 

LHmiOper_vbsCloseAZERTYKeyboard 

The "LHmiOper_vbsCloseAZERTYKeyboard" script closes the 
"LHmiOper_popupAZERTYKeyboard" pop-up screen and writes the entered string 
into the associated HMI tag "valueAZERTYKeyboard". 

LHmiOper_vbsOpenCyrKeyboard 

The "LHmiOper_vbsOpenCyrKeyboard" script opens the  
"LHmiOper_popupCyrKeyboard" pop-up screen. 

LHmiOper_vbsCloseCyrKeyboard 

The "LHmiOper_vbsCloseCyrKeyboard" script closes the 
"LHmiOper_popupCyrKeyboard" pop-up screen and writes the entered string into 
the associated HMI tag "valueCyrilicKeyboard". 

LHmiOper_vbsOpenLangKeyboard 

The "LHmiOper_vbsOpenLangKeyboard" script opens the 
"LHmiOper_popupLangKeyboard" pop-up screen. 

LHmiOper_vbsCloseLangKeyboard 

The "LHmiOper_vbsCloseLangKeyboardClose" script closes the 
"LHmiOper_popupLangKeyboard" pop-up screen and writes the entered string into 
the associated HMI tag "valueLangKeyboard". 

LHmiOper_vbsOpenNumKeyboard 

The "LHmiOper_vbsOpenNumKeyboard" script opens the 
"LHmiOper_popupNumKeyboard" pop-up screen. 

LHmiOper_vbsCloseNumKeyboard 

The "LHmiOper_vbsCloseNumKeyboard" script closes the 
"LHmiOper_popupNumKeyboard" pop-up screen and writes the entered string into 
the associated HMI tag "valueNumericKeyboard". 

LHmiOper_vbsOpenQWERTYKeyboard 

The "LHmiOper_vbsOpenQWERTYKeyboard" script opens the 
"LHmiOper_popupQWERTYKeyboard" pop-up screen. 

LHmiOper_vbsCloseQWERTYKeyboard 

The "LHmiOper_vbsCloseQWERTYKeyboard" script closes the 
"LHmiOper_popupQWERTYKeyboard" pop-up screen and writes the entered string 
into the associated HMI tag "valueQWERTYKeyboard". 

LHmiOper_vbsActivateStandardKeyboard 

The "LHmiOper_vbsActivateStandardKeyboard" script opens the standard 
keyboard. 
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LHmiOper_vbsDeactivateStandardKeyboard 

The "LHmiOper_vbsDeactivateStandardKeyboard" script closes the standard 
keyboard. 
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16.2 Integration into the user project 

16.2.1 Integrating on-screen keyboards into your configuration 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiOper > 
Keyboards" of the library. 

3. Drag the elements (Template, Screens, PopUp Screens, Scripts, Tag table) to 
the corresponding folder of the operator panel. 

Figure 16-6 
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Note 

Depending on the size of the HMI operator panel, it may be necessary to adapt 
the screens. 
 

4. Drag the "btnKeyboards" button from the library to your screen. You open the 
tool with this button. 

5. Open the "LHmiOper_Keyboards" screen. 

6. Close the standard on-screen keyboard when the screen is called. To do so, 
call the system function "SetScreenKeyboardMode" for the "Loaded" event of 
the screen and set the mode to "Off". 

Figure 16-7 

 

7. Activate the standard on-screen keyboard once again when the screen is 
closed. To do so, call the system function "SetScreenKeyboardMode" for the 
"Cleared" event of the screen and set the mode to "On". 

Figure 16-8 

 

8. Add an I/O field and a button with "Toolbox > Elements". 

Note 
You can configure the "Invisible" button and position it over the I/O field. This 
gives you the option of calling the keyboard with a click on the field. 

9. Add the open script of the keyboard of your choice to the "Click" event.  

Select "String" as data type and enter the tag name of the associated tag of the 
selected keyboard. 

Figure 16-9 
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10. Add the close script of the keyboard to the "Input finished" event of the I/O 
field. 

Figure 16-10 

 

11. Open the Open script of the keyboard. If necessary, adjust the position at 
which the on-screen keyboard is opened in the script. 

 

 

16.2.2 Notes, tips & tricks 

Style settings 

Each keyboard is realized as a faceplate and offers the "Design" category with 
different style properties at its interface.  

You can connect existing style elements to these style properties. You apply the 
style of the connected elements with the "useStyle" property. 

Figure 16-11 
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Note For the basic principles and further information on the use, processing and 
creation of styles, please refer to the application example  
"SIMATIC HMI Operator Panels - Innovative Design and Operation". 

The link is available in the document list under \6\. 

On-screen keyboard in dialogs 

You cannot do a covered input with the customizable on-screen keyboard. Thus 
you must use the WinCC standard on-screen keyboard for system dialogs (e.g. 
Login).  

1. Copy the scripts "SystemdialogueScripts" from the library into the VB scripts 
folder of your operator panel. 

 

2. Copy the tasks "LHmiOper_OpenDialogue" and "LHmiOper_CloseDialogue" 
into the scheduler. 

Decimal separator 

You can define in the Panel’s or PC’s regional settings which sign is used as 
decimal separator. 

 

1. Open the settings for the decimal separator and change it to one of your 
choice. 

– On the Panel, you can find this setting in the "Control Panel" under 
"Regional Settings > Number > Decimal symbol".  

– On the PC, you can find this setting in the "Control Panel" under "Region 
and Language > Formats > Additional settings > Decimal symbol". 
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Figure 16-12 

 

2. Open the tag table "LHmiOper_Keyboards". 

3. Open the properties of the tag "decimalSeparatorNumericKeyboard" and 
specify the "Start value".  

– 0: Delimiter point (.) 

– 1: Delimiter comma (,)  
 

Figure 16-13 

 

Data types and fonts of screen objects 

In on-screen keyboards with Cyrillic characters use a data type appropriate for 
Unicode (e.g. WString). In addition, the font of the buttons and I/O fields must 
contain a Cyrillic character set. Options are, for example: 

• Tahoma 

• Arial 

Language-dependent keyboard 

The set language is checked when the keyboard 
"LHmiOper_popupLanguageKeyboard" is opened.  

Thus always change the language when the keyboard is closed or open the 
keyboard again after having changed the language. 
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16.3 Operation 

1. Open the visualization on your operator panel or simulate it. 

2. Open the Tools overview and click on the "Keyboards" button. 

3. Open a keyboard of your choice by clicking on the I/O field or the "OPEN" 
button. 

Figure 16-14 

 

4. Enter a value of your choice and confirm the entry with "OK".  

Note 
The "Esc" button closes the keyboard without applying the value. 

Figure 16-15 
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17 Simplified operation – Home button 

17.1 General description 

The operation of the Home button is as intuitive as you are used to it with your 
smartphone or tablet. The button recognizes a short or long click with the help of a 
function block in the controller. 

The tool is configured so that the start screen opens with a short click on the 
button. A long click opens the second overview page of the tools. 

Figure 17-1 

 

 

17.1.1 Hardware and software components 

This application example is valid for: 

• SIMATIC STEP 7 Professional V15.1 

• SIMATIC WinCC Comfort / Advanced V15.1 

• SIMATIC S7-1500  

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels,  
Mobile Panels 2nd Generation 

• SIMATIC WinCC RT Advanced V15.1 
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17.1.2 Data types and function blocks used 

This section explains the functions of the function blocks and data types used in 
the tool. 

LHmiOper_DelayButton 

The function block "LHmiOper_DelayButton" calculates the time  
the "Home Button" has been pressed and sets the tags "shortClick" or "longClick" 
as a function of length of time of clicking. 

 

Figure 17-2: Function block "LHmiOper_DelayButton" 

  
LHmiOper_DelayButton 

  
    

Bool 
  

req shortClick 
  

Bool 
    

Time 
  

delay longClick 
  

Bool 
    

 

 

Table 17-1: LHmiOper_DelayButton parameters 

Name P 
type 

Data 
type 

Comment 

req IN Bool Trigger for FB enable 

delay IN Time Period of time which must elapse at least between short 
and long clicking 

shortClick OUT Bool Status for short click 

longClick OUT Bool Status for long click 

 

17.1.3 VBS scripts used 

This section explains the functions of the scripts used in the tool. 

LHmiOper_vbsPressedLongHomeButton 

The "LHmiOper_vbsPressedLongHomeButton" script is executed when the button 
is clicked for a longer time than the set delay time. As a result, the "Slide-in screen 
right" is called in the application example. 

LHmiOper_vbsPressedShortHomeButton 

The "LHmiOper_vbsPressedShortHomeButton" script is executed when the button 
is clicked for a shorter time than the set delay time. As a result, the 
"Tools_Overview2" screen is called in the application example. 
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17.2 Integration into the user project 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiOper > 
HomeButton" of the library. 

3. Drag the elements (Template, Screen, Scripts, Tag table) to the corresponding 
folder of the operator panel. 

Figure 17-3 

 

Note 

Depending on the size of the HMI operator panel, it may be necessary to adapt 
the screen. 
If your HMI connection to the PLC is not called "HMI_Connection_1", update 
your HMI connection in the tag table. 

You must also synchronize the HMI tags again with the PLC tags. 
 

4. Drag the "btnHomeButton" button from the library to your screen. You open the 
tool with this button. 

5. Open the "LHmiOper_HomeButton" screen. Drag the "grpHomeButton" screen 
object grouping from the library to your screen. 
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6. Open the "LHmiOption_vbsPressedLongHomeButton" script and change the 
result for a long click in the If loop to one of your choice. 

Repeat the process for the script for a short click. 

Figure 17-4 

   

 

7. Open the folder "Master copies > > 01_PLC > 03_Tools > 01_Blocks > 
LHmiOper" of the library. 

8. Drag the data block "LHmiOper_CommDB" to the "Program blocks" folder of 
your PLC. 

Figure 17-5 

 

Note 
All tags that are required for the Home button have the prefix "homeButton". 

If you have already integrated the data block in connection with another tool, 
you can skip this step. 

9. Open the folder "Types > 03_Tools > 01_Blocks > LHmiOper > HomeButton" 
of the library. 

10. Drag the function blocks "LHmiOper_DelayButton" to the "Program blocks" 
folder of your PLC. 

Figure 17-6 
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11. Call the function block "LHmiOper_DelayButton" in your user program and 
interconnect the inputs and outputs with the corresponding tags of the 
communication DB. 

At the "delay" input, specify the time after which the Home button is to 
distinguish between a "long" and a "short" click. 

Figure 17-7 

 

12. Download the software to your operator panel and your PLC or start the 
simulation. 
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17.3 Operation 

1. Open the visualization on your operator panel or simulate it. 

2. Open the Tools overview and click on the "Home button" button. 

3. Press the Home button briefly to open the tool overview. 

Figure 17-8 

 

4. Repeat step 2 and press the Home button longer (> 2 s) to open the slide-in on 
the right. 
The edge of the button turns light when the Home button is clicked for a long 
time. The slide-in right opens. 

Figure 17-9 
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18 Simplifying operation – Screen saver 

18.1 General description 

Use a screen saver to protect the screen of the SIMATIC Panel. You may define 
yourself a screen saver object (e.g. your Company logo) using the screen savers 
included in this application example. 

Dimming the screen brightness also protects the SIMATIC Panel. 

Figure 18-1 

 

 

This application example describes two ways to configure a screen saver: 

 

1. Solution without controller 
The screen saver is enabled when the screen has not changed for a time 
longer than a specific, adjustable period (minimum: 1 minute).  
If the operator uses the panel without changing the screen, the screen saver 
will be enabled nevertheless in this solution. 
 

2. Solution with controller 
The screen saver is enabled when no operation has taken place on the 
operator panel for a time longer than a specific, adjustable period. This solution 
evaluates both the active screen and the active object with the result that the 
screen saver is only enabled when no operation occurs. 
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18.1.1 Hardware and software components 

Solution without controller 

This application example is valid for: 

• SIMATIC WinCC Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels, Mobile 
Panels 2nd Generation 

• SIMATIC WinCC RT Advanced V15.1 

Solution with controller 

This application example is valid for: 

• SIMATIC STEP 7 Basic / Professional V15.1 

• SIMATIC WinCC Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels,  
Mobile Panels 2nd Generation 

• SIMATIC WinCC RT Advanced V15.1 

• SIMATIC S7-1200 / S7-1500 

 

18.1.2 Data types and function blocks used 

This section explains the functions of the function blocks and data types used in 
the tool. 

LHmiOper_CheckPanelActivity 

The function block "LHmiOper_CheckPanelActivity" calculates if the screen saver 
shall be enabled, as well as the position in x and y for the logo moving through the 
screen. 

The function block randomly calculates the values output parameter "x position" 
and "y position" between "0" and the maximum values set in the control cycle.  

 

Figure 18-2: Function block "LHmiOper_CheckPanelActivity" 

  
LHmiOper_CheckPanelActivity 

  
    

UInt 
  

screenNo inactive 
  

Bool 
    

UInt 
  

objectNo xPosition 
  

Int 
    

Time 
  

delayTime yPosition 
  

Int 
    

Int 
  

xPositionMax 
    

      

Int 
  

yPositionMax 
    

      

 

 

Table 18-1: LHmiOper_CheckPanelActivity parameters 

Name P 
type 

Data 
type 

Comment 

screenNo IN UInt Pointer to screen number 

objectNo IN UInt Pointer to current object 
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Name P 
type 

Data 
type 

Comment 

delayTime IN Time Period of time which must elapse at least between 
short and long clicking 

xPositionMax IN Int Maximum x coordinate for the logo 

yPositionMax IN Int Maximum y coordinate for the logo 

inactive OUT Bool Screen saver status 

xPosition OUT Int x coordinate for the logo 

yPosition OUT Int y coordinate for the logo 

 

18.1.3 VBS scripts used 

This section explains the functions of the scripts used in the tool. 

LHmiOper_vbsActivateIntScreensaver 

The script "LHmiOper_vbsActivateIntScreensaver" activates the screen 
"LHmiOper_IntScreensaver" and determines the time in which the screen saver is 
called. 

LHmiOper_vbsActivateExtScreensaver 

The script "LHmiOper_vbsActivateExtScreensaver" activates the screen 
"LHmiOper_ExtScreensaver". 

LHmiOper_SetBrightnessScreensaver 

The script "LHmiOper_SetBrightnessScreensaver" sets the screen brightness for 
your SIMATIC Panel to the percentage value of the transferred "brightness" 
parameter. 
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18.2 Integration into the user project 

18.2.1 Integration without controller 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiOper > 
Screensavers > 00_Internal" of the library. 

3. Drag the elements (Screen, Scripts, Tag table, Tasks) to the corresponding 
folder of the operator panel. 

Figure 18-3 

 

Note 

Depending on the size of the HMI operator panel, it may be necessary to adapt 
the screen. 
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4. Open the script "LHmiOper_vbsActivateIntScreensaver". 

In line 5, enter a time in minutes after which the screen saver is to be activated 
(in the example: 2 minutes). 

Figure 18-4 

 

 

5. Open the "LHmiOper_IntScreensaver" screen. 

6. Adjust the parameters screen brightness as well as the x position and y 
position of the screen (logos) to your screen size. 
Depending on the settings, the x and y position is calculated in a predefined 
cycle and the logo is moved through the screen using the "Direct movement" 
event. 

Figure 18-5 

 

7. Download the software to your operator panel or start the simulation. 
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18.2.2 Integration with controller 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiOper > 
Screensaver > 01_External" of the library. 

3. Drag the elements (Template, Screens, Scripts, Tag table, Tasks) to the 
corresponding folder of the operator panel. 

Figure 18-6 

 

Note 

Depending on the size of the HMI operator panel, it may be necessary to adapt 
the screen. 

If your HMI connection to the PLC is not called "HMI_Connection_1", update 
your HMI connection in the tag table. 

You must also synchronize the HMI tags again with the PLC tags. 

4. Drag the "btnScreensaver" button from the library to your screen. You open the 
tool with this button. 
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5. Drag the data block "LHmiOper_CommDB" to the "Program blocks" folder of 
your PLC. 

Figure 18-7 

 

Note 
All tags that are required for the screen saver have the prefix "screensaver". 

If you have already integrated the data block in connection with another tool, 
you can skip this step. 

6. Open the "LHmiOper_Screensavers" screen. 

7. Select the switch and open the block interface with "Properties > Interface". 

Connect the "LHmiOper_ActivateExtScreensaver" tag to the "Value" property 
of the "Properties_Faceplate" category. 

Figure 18-8 

 

 

Note 
In the example project, the external screen saver is activated with a switch. If 
you want to activate it permanently, follow these steps: 

– At the "Loaded" event of the start screen, add the system function 
"SetTag".  

– Select the HMI tag "LHmiOper_ActivateExtScreensaver" and set the value 
to 1. The screen saver is set to "active" as a result. 

8. Open the "Connections" editor of the HMI operator panel and select the 
connection "HMI_Connection_1". 
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9. Configure the global area pointer for the screen number. 

– PLC tag: "LHmiOper_CommDB.areaPointerExtScreensaver" 

– Connection: "HMI_Connection_1" 

 

10. Open the folder "Types > 03_Tools > 01_Blocks > LHmiOper > Screensaver" 
of the library. 

11. Drag the function block "LHmiOper_CheckPanelActivity" to the "Program 
blocks" folder of your PLC. 

Figure 18-9 

 

12. Call the function block "LHmiOper_CheckPanelActivity" in your user program 
and interconnect the inputs and outputs with the corresponding tags of the 
communication DB. 

For the "delayTime" set the time of inactivity after which the screen saver is to 
be activated. 

Figure 18-10 

 

13. Download the software to your operator panel and your PLC or start the 
simulation. 
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18.3 Operation 

1. Open the visualization on your operator panel. 

2. Wait for 1 minute without operation. The internal screen saver opens. 

Figure 18-11 

 

3. Open the Tools overview and click on the "Screensaver" button. 

Tip/click the screen to close the internal screen saver and activate the previous 
screen. 

4. Activate the switch.  

Figure 18-12 

 

 

5. Wait for 15 seconds. The external screen saver opens. 

6. Tip/click the screen to close the external screen saver and activate the 
previous screen. 
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19 Simplifying operation – Checkbox/Radio 
button 

19.1 General description 

The standard version of SIMATIC WinCC Comfort / Advanced contains 
checkboxes and radio buttons only for SIMATIC WinCC Professional. The 
application example contains faceplates for checkboxes / radio buttons that you 
can use in your configuration. 

You can set the number of checkboxes and radio buttons as needed (up to 8) at 
the interface of the faceplates. 

The selection is made available as status value at the interface of the faceplates. 
The boxes are binary encoded. Thus, the decimal value results from the binary 
encoding. 

 

Figure 19-1 

 

 

Figure 19-2 
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19.1.1 Hardware and software components 

This application example is valid for: 

• SIMATIC WinCC Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels, Mobile 
Panels 2nd Generation 

• SIMATIC WinCC RT Advanced V15.1 

 

Note Unlike a classic radio button in which one option always remains active, all 
options can be deselected with this radio button. 
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19.2 Integration into the user project 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiOper > 
CheckRadioBox" of the library. 

3. Drag the elements (Template, Screens, Tag table) to the corresponding folder 
of the operator panel. 

Figure 19-3 

 

Note 

Depending on the size of the HMI operator panel, it may be necessary to adapt 
the screens. 

4. Drag the "btnCheckRadiobox" button from the library to your screen. You open 
the tool with this button. 

5. Open the folder "Types > 03_Tools > 03_Faceplates > LHmiOper > 
CheckRadiobox" of the library. 

Figure 19-4 

 



19 Simplifying operation – Checkbox/Radio button 

 

Toolbox für HMI-Projekte 
Entry ID: 106226404,    V5.0,    02/2019   138 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

6. Open a screen and copy the desired faceplate "LHmiOper_fpCheckBox" or 
"LHmiOper_fpRadioBox" to your screen. 
The faceplate is automatically copied to your project library. 

7. Select the faceplate and open the interface of the faceplate. 

Figure 19-5 

 

 

8. Connect the associated tags from the tag table to the properties of the "Values" 
category.  
Use the property "numberOfxxxx" to specify how many of the checkboxes or 
radio buttons are displayed (maximum of 8). Use the property "returnValue" to 
read which checkboxes or radio buttons are selected.  

9. Set the labeling texts next to the individual boxes.  
You configure the labeling texts with the properties of "Labels" category. 
You specify the style of the faceplate in the "Design" category.  

10. Download the software to your operator panel or start the simulation. 

 

Note The faceplates can also be used outside of the screens "LHmiOper_Checkbox" 
and "LHmiOper_Radiobox". 

The screens serve as an example for the integration. 
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19.3 Operation 

Note The operation is explained with the help of the example project. When you use 
the tool in your own configuration, the call may be somewhat different. 

The basic functionalities are not affected by this. 

 

1. Open the visualization on your operator panel. 

2. Open the tools overview and click on the "Check/radiobox" button. 
The screen with the faceplate for the checkbox opens. 

3. Enter a number for the checkboxes that are going to be displayed. 

Select the checkboxes of your choice.  
The associated decimal value is displayed in the "Value" I/O field. 

Figure 19-6 

4

 

4. Open the screen with the faceplate of the radio button using the "Check-
/Radiobox - Radiobox" button in the page navigation on the left. 

5. Enter a number for the radio buttons that are going to be displayed. 

6. Select a radio button of your choice.  
The associated decimal value is displayed in the "Value" I/O field. 

Figure 19-7 

4
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20 Simplified operation – Moving pop-up 
screens 

20.1 General description 

As of WinCC Comfort / Advanced V13 SP1 you can use pop-up screens  
in the configuration. This is useful, for example, to display notes independently of 
the currently opened screen. You can also source out process variables which are 
only needed on request by the operator and save performance this way. 

The call of the pop-up screens is static and cannot be adapted to the runtime. The 
"Move pop-up screens" tool helps you expand the scope of functions of your pop-
up screens. The operator may move pop-up screens during runtime with the help 
of a move button so that operating elements in the background become visible. A 
pop-up screen offers various options for moving to the user. 

 

Figure 20-1 

 

 

20.1.1 Hardware and software components 

This application example is valid for: 

• SIMATIC WinCC Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels, Mobile 
Panels 2nd Generation 

• WinCC RT Advanced V15.1 

 

20.1.2 VBS scripts used 

This section explains the functions of the scripts used in the tool. 

LHmiOper_vbsMovePopUpScreen 

The "LHmiOper_vbsMovePopUpScreen" script calculates the new position of the 
pop-up screen based on the screen size, the parameters of the pop-up screen and 
the pressed position button. The pop-up screen is subsequently called at the new 
position. 
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20.2 Integration into the user project 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiOper > 
MovePopUpScreen" of the library. 

3. Drag the elements ("LHmiOper_popupPosition" pop-up screen, Script, Tag 
table) to the corresponding folder of the operator panel. 

Figure 20-2 

 

Note 

Depending on the size of the HMI operator panel, it may be necessary to adapt 
the pop-up screen. 

The library also contains the pop-up screen "LHmiOper_popupMovePopUps" 
and the button "btnShowMovePopUp". They are needed for the example 
project and are not part of the tool. 

The pop-up screen "LHmiOper_popupMovePopUps" contains the button 
"btnMovePopUp" and only serves as an example for the integration of the tool 
into a pop-up screen. 

The button "btnShowMovePopUp" is used to call the pop-up screen 
"LHmiOper_popupMovePopUps" in a screen. 
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4. Open the script "LHmiOper_vbsMovePopUpScreen" and set the values for 
"maxheight" and "maxwidth" according to the screen size of the HMI operator 
panel used. 

Figure 20-3 

 

5. In the first "Case" instruction (line 62), change the transfer parameter of the 
system function "ShowPopUpScreen" to the name of your pop-up screen by 
using the tool.  

Figure 20-4 

 

Note 

If you are using the tool in multiple pop-up screens, add additional "Case" 
instructions with the next higher value for the locations of use.  

6. Open a pop-up screen in which you want to use the tool.  

7. Drag the "btnMovePopUp" button from the library (see Figure 20-2) to your 
pop-up screen. You open the tool with the button. 

8. Select the button and open the "Events" of the button. Open the "Click" event. 

Figure 20-5 
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In the "SetTag" system function, change the value of the 
"LHmiOper_selPopup" tag. The value must be identical to the value you have 
used in the script in the "Case" instruction for calling the corresponding pop-up 
screen. 

Figure 20-6

 

9. In the "SetTag" system function, change the value of the 
"LHmiOper_popupWidth" and "LHmiOper_popupHeight" tags to the width and 
height of your pop-up screen by using the tool. 

You can find these values in the properties of the pop-up screen in the area 
"Layout > Size". 

Figure 20-7 

 

10. Optional  

Adjust the x and y coordinate for calling the pop-up screen 
"LHmiOper_popupPosition". 

Figure 20-8 

 

Note 

The pop-up screen "LHmiOper_popupPosition" is called after pressing the 
move button "btnMovePopUp" and offers the user a button with moving 
options. 

 

11. Download the visualization to your operator panel or simulate it. 
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20.3 Operation 

Note The operation is explained with the help of the example project. When you use 
the tool in your own configuration, the call may be somewhat different. 

The basic functionalities are not affected by this. 

 

1. Open the visualization on your operator panel. 

2. Open the Tools overview and click on the "Move Pop-up" button. The pop-up 
screen "Move Pop-up screens" with the move button opens.  

Figure 20-9 

 

 

3. Press the move button. A pop-up screen with the nine moving options opens.  

Figure 20-10 
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4. Press a button of your choice. 

Figure 20-11 

 

5. The pop-up screen "Move Pop-up screens" is moved and displayed at the 
selected position in the screen. 

Figure 20-12 

 

 

6. Close the pop-up screen with the "Cancel" button. 
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21 Simplified operation – Segmented control 

21.1 General description 

A Segmented Control helps you clearly and quickly define the value of a process 
tag. This allows you to specify potential values beforehand and avoid operating 
errors. 

This application example offers you four different faceplates for SIMATIC Comfort 
Panels / WinCC RT Advanced. The value range is divided up into values of 6 or 11. 
The difference between the values is always the same.  

The value is selected with buttons and applied as tag value for the tag 
parameterized at the interface. 

The labeling and display can be changed via the interface of the blocks. 

 

LHmiOper_fpSegment6 / LHmiOper_fpSegment11 

The value range of these faceplates is between 0 and 100.  

It is divided up into 6 (steps of 20) or 11 (steps of 10) equidistant steps.  The values 
are always integer values. 

The values for minimum (0) and maximum (100) cannot be changed.  

You can change the labeling for the unit via the block interface. 

Figure 21-1 
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LHmiOper_fpSegmentMinMax6 / LHmiOper_fpSegmentMinMax11 

The value range of these faceplates is between the values for minimum 
("LHmiOper_minSegControl" tag) and maximum ("LHmiOper_maxSegControl" 
tag).  

The range is divided up into 6 or 11 equidistant steps. The values are always 
integer values.  

You can use the I/O fields to set the tag values during runtime as needed. 

Figure 21-2 

 

 

21.1.1 Hardware and software components 

This application example is valid for: 

• SIMATIC WinCC Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels,  
Mobile Panels 2nd Generation 

• SIMATIC WinCC RT Advanced V15.1 
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21.2 Integration into the user project 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiOper > 
SegmentedControl" of the library. 

3. Drag the tag table to the corresponding folder of the operator panel. 

Figure 21-3 

 

Note 
The library also contains the template "TemplateSegmentedControl", the 
screens "LHmiOper_SegmentedControlFixed" and 
"LHmiOper_SegmentedControlVariable" as well as the button 
"btnSegmentedControl" for calling the "LHmiOper_SegmentedControlFixed" 
screen.  

They are needed for the example project and are not part of the tool. 
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4. Open the folder "Types > 03_Tools > 03_Faceplates > LHmiOper > 
SegmentedControl" of the library. 

Figure 21-4 

 

5. Open a screen of your choice. Drag and drop a segmented control of your 
choice to the screen. The faceplate is automatically copied to your project 
library. 

6. Select the faceplate and open the interface of the faceplate. 

Figure 21-5 
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7. Connect the associated tags from the tag table to the properties of the "Values" 
category.  

– "tagResult": Selected tag value  

 

Only for faceplates "LHmiOper_fpSegmentMinMax6" and 
"LHmiOper_fpSegmentMinMax11" 

– "MIN": Minimum value 

– "MAX": Minimum value 

Figure 21-6 

 

8. Optional 
You configure the labeling texts for the buttons within the faceplates 
"LHmiOper_fpSegmented6" and "LHmiOper_fpSegmented11" with the 
properties of the "Labels" category. 

Figure 21-7 
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Figure 21-8 

 

 

9. Optional 
You specify the style of the screen objects in the faceplate in the "Design" 
category.  

Figure 21-9 

 

Figure 21-10 

 

10. Download the software to your operator panel or start the simulation. 
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21.3 Operation 

Note The basis for this chapter is the example project. The operation of the tool is 
described based on the example project. 

 

1. Open the visualization on your operator panel. 

2. Open the Tools overview and click on the "Seg. Control" button. The screen 
with the segmented controls opens.  

3. Enter a value for minimum and maximum (2). 

Select a value for the two controls (3)(4). The value is written to the tag and 
displayed in the associated I/O field (5). 

Figure 21-11 

5

 

 

  



21 Simplified operation – Segmented control 

 

Toolbox für HMI-Projekte 
Entry ID: 106226404,    V5.0,    02/2019   153 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

4. Use the "Segmented Control – Fixed division" button in the page navigation on 
the left to the screen with the controls in fixed division (1). 

Select a value for the two controls (2)(3). The value is written to the tag and 
displayed in the associated I/O field (4). 

Figure 21-12 

4
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22 Increase clarity – Notes 

22.1 General description 

The Notes tool allows the operator of the panel /  
WinCC RT Advanced to process text notes. The tool saves the entered notes in a 
text file to the memory of the HMI operator panel.  

The tool provides an overview of all notes in the "Overview" area. 

Figure 22-1 

 

 

You create new notes or overwrite existing notes that you no longer need with the 
note number and note text. 

Figure 22-2 

 

 

 

The tool also lets you save notes and load them when needed. 
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Figure 22-3 

 

 

22.1.1 Hardware and software components 

This application example is valid for: 

• SIMATIC WinCC Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels,  
Mobile Panels 2nd Generation 

• SIMATIC WinCC RT Advanced V15.1 

 

22.1.2 VBS scripts used 

This section explains the functions of the scripts used in the tool. 

LHmiView_vbsCopyToCurrentNote 

The "LHmiView_vbsCopyToCurrentNote" script copies the current note entry to the 
associated HMI tag depending on the note number (No.). 

LHmiView_vbsCopyToNotes 

The "LHmiView_vbsCopyToNotes" script copies the note entries to the associated 
HMI tags for the table view depending on the note number (No.). 

LHmiView_vbsReadNotesFromDisk 

The "LHmiView_vbsReadNotesFromDisk" script reads the note entries stored on 
the panel from the associated text file "LHmiView_Notes.txt" and saves them to the 
associated HMI tags for the table view depending on the note number (No.). 

LHmiView_vbsWriteNotesFromDisk 

The "LHmiView_vbsWriteNotesFromDisk" script writes the current note entries of 
the table view to a text file "LHmiView_Notes.txt" and saves them on the operator 
panel. 
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Note The configuration of the file system differs, depending on the operating system 
(Windows / Windows CE) of your HMI operator panel.  

As a result, the storage of the "LHmiView_Notes.txt" file is also different. 

• Panels path: \flash\106226404_Tools\ 

• WinCC RT Advanced path: C:\106226404_Tools\ 

 

You can change the storage path in the script at any time. 
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22.2 Integration into the user project 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiView > Notes" of 
the library. 

3. Drag the elements (Template, Screens, Scripts, Tag table) to the 
corresponding folder of the operator panel. 

Figure 22-4 

 

Note 

Depending on the size of the HMI operator panel, it may be necessary to adapt 
the screens. 

4. Drag the "btnNotes" button from the library to a screen of your choice. You 
open the screen "LHmiView_NotesTable" with the Notes Overview with this 
button. 

5. Download the visualization to your operator panel or simulate it. 
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22.3 Operation 

Note The operation is explained with the help of the example project. When you use 
the tool in your own configuration, the call may be somewhat different. 

The basic functionalities are not affected by this. 

 

1. Open the visualization on your operator panel. 

2. Open the Tools overview and click on the "Notes" button. The screen with the 
Notes Overview opens. 

3. Open the screen for adding a new note with the "Notes – Add new note" button 
or click on the text entry of a note of your choice. 

Figure 22-5 

 

4. Enter a note number and note text of your choice (1). 

Click the "ADD" button to add the note (2).  
The screen with the Notes Overview opens and the note is added. 

Figure 22-6 
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5. Open the screen for saving and loading notes with the "Notes – Save / Load" 
button in the page navigation on the left (1). 

Save the notes with the Save button (2). 

Figure 22-7 

 

6. Change a note of your choice. 

7. Open the screen for saving and loading notes again (1). 

Select the saved note file with the "OPEN" button (2) and load it using the Load 
button (3). 
The saved notes are written to the HMI tag and displayed in the Notes 
Overview. 

Figure 22-8 
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23 Increase clarity – Gauge controls for Basic 
Panels 

23.1 General description 

Gauge controls are dynamic display objects that are able to visualize numeric 
values with the help of a pointer. 

They are available for WinCC Comfort / Advanced / Professional under "Elements" 
in the "Tools" task card.  

The following section shows how you can also use gauge controls with WinCC 
Basic. 

Figure 23-1 

 

 

The gauge controls shown here are not controls as they are available for 
WinCC Comfort / Advanced / Professional. They are graphic lists whose elements 
are displayed via a graphic I/O field. The associated element of the graphic list is 
displayed based on a standardized process tag that is rounded to an integer 
number.  

The library offers gauge controls with a value range from 0 to 100 and with a free 
scale. The predefined value range can be used, for example, to display percentage 
values. 

Figure 23-2 

Prozessvariable

Erzeugung Steuervariable:

Normierung, Skalierung, 

Änderung Datentyp auf Ganzzahl 

im Wertebereich 0 bis 100

Grafisches 

E/A-Feld

Grafikliste
Zeigerinstrument

 

 

23.1.1 Hardware and software components 

This application example is valid for: 

• WinCC Basic, Comfort, Advanced V15.1 
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• SIMATIC Basic Panels 
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23.2 Basics 

Normalization of the control tags 

The graphic lists in this application example have 101 graphics each, representing 
integer values from 0 to 100.  

The control tag must be of an "Integer" data type and have a value range from 0 to 
100. 

In the STEP 7 program, the following steps must be performed to convert the 
process tag into the control tag. 

• Normalize and scale any value range to the value range from 0.0 to 100.0 

• Round floating-point numbers to an "integer" data type value 

 

Figure 23-3 

Normierung

von 0 bis 1

Prozesswert Skalierung

*100

Rundung auf

Ganzzahl

 

The mathematical functions for calculating the control tags can be found in the 
"Instructions" task card, "Basic instructions" pane, in the "Conversion operations" 
and "Math functions" folders: 

 

• NORM_X (for S7-1200/1500) – normalized from 0.0 to 1.0

 

• MUL – multiply 

• ROUND – round to the next integer 

• TRUNC – truncate decimal places and convert to integer 
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Basics on gauge controls 

The library included in the application example provides three different styles of 
gauge controls.  

The "rotation tool" that can also be downloaded in this entry allows you to create 
similar gauge controls that suit your style. 

Table 23-1 

Style  
"Controlled Complexity" 

style  
"Dynamics" 

style  
"Reliability" 

 
 

  

 
 

  

 

The gauge controls are available in sizes 200px * 200px and 300px * 300px.  

 

Note To save storage space, use only one gauge control style and size in the project, 
if possible. 

Depending on the size, the graphic I/O field with the gauge control graphic list 
requires about 1.5 MB to 3.9 MB of storage space when first integrated into the 
project. Each additional use of the same graphic I/O field (same size and same 
graphic list) in the project requires only a very small amount of additional storage 
space. 

 

Note You can also use the gauge controls for SIMATIC Comfort Panels or WinCC RT 
Advanced. 
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23.3 Integration into the user project 

Note Requirement for the integration is that there is already an integer tag for 
connection to the gauge control in your project. 

 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiView > Gauges" 
of the library. 

3. Add a new screen to your configuration.  

4. Drag and drop one of the gauge controls from the library to your screen. 

Figure 23-4 

 

5. Open the properties of the graphic I/O field and select the control tag for 
display under "General > Process > Tag:". 
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6. When you use a gauge control with free scaling, you can change the labeling 
of the unit and the scale in the "Texts" tab. 

 

 

In addition, gauge controls with free scaling include an I/O field for the actual 
value. Select the process tag under "Properties > General > Process > Tag:". 

 



24 Increase clarity – Gauge controls for Comfort Panel / WinCC RT Advanced 

 

Toolbox für HMI-Projekte 
Entry ID: 106226404,    V5.0,    02/2019   166 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

24 Increase clarity – Gauge controls for 
Comfort Panel / WinCC RT Advanced 

24.1 General description 

Many plant operators would like to get an idea of the status and performance of 
their plant with a mere look at the visualization. There is a variety of integer 
performance indicators for this: 

• Availability 

• Power factor 

• Quality factor 

• Efficiency 

• Effectiveness 

You can use the "Gauge control" from the "Tools" task card for this purpose. 
However, the configuration of "gauge controls" is very time-consuming. This is why 
the library provides a variety of preset gauge controls with the value range 0…100. 
This will save time during configuration. 

 

Figure 24-1 

 

 

24.1.1 Hardware and software components 

This application example is valid for: 

• WinCC Comfort, Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels,  
Mobile Panels 2nd Generation 

• SIMATIC WinCC RT Advanced V15.1 
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24.2 Integration into the user project 

Note Requirement for the integration is that there is already an integer tag for 
connection to the gauge control in your project. 

 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiView > Gauges" 
of the library. 

3. Add a new screen to your configuration.  

Drag and drop a gauge control of your choice from the library to your screen. 

Figure 24-2 

 

4. Open the properties of the graphic I/O field and connect a process tag of your 
choice under "General > Process > Tag:" (1). Adapt the format settings as in 
Figure 24-3 (2). 

Figure 24-3 
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5. Open the properties of the gauge control and connect a process tag from the 
I/O field under "General > Process > Tag:" (1). 

Adapt the title of the gauge control under "Label" (2). 

Figure 24-4 
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25 Increase clarity – File Explorer 

25.1 General description 

The default file browser allows you to select any file in the file system of the 
operator panel and save it in your project as a WinCC tag for further use. 

The "File Explorer" tool enables you to use extended file functions such as 
"Delete", "Rename" or "Search" of files / folders.  

The File Explorer is fully integrated into the runtime environment so that the 
operator does not need to access the operating system. 

 

Figure 25-1 

 

 

25.1.1 Hardware and software components 

This application example is valid for: 

• WinCC Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels,  
Mobile Panels 2nd Generation 

• SIMATIC WinCC RT Advanced V15.1 
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25.1.2 VBS scripts used 

This section explains the functions of the scripts used in the tool. 

LHmiView_vbsFECreateFolder 

The "LHmiView_vbsFECreateFolder" script creates a new folder in the file system. 

LHmiView_vbsFEDelete 

The "LHmiView_vbsFEDelete" script deletes the selected file/folder from the file 
system.  

LHmiView_vbsFEMove 

The "LHmiView_vbsFEMove" script allows copying, cutting and inserting the 
selected file in the file system. The "sender" transfer parameter defines the mode: 

• 1: Copy 

• 2: Paste 

• 3: Cut 

LHmiView_vbsFEPreviousFolder 

The "LHmiView_vbsFEPreviousFolder" script opens the higher-level folder of the 
currently selected folder. 

LHmiView_vbsFEReadFilesOfFolder 

The "LHmiView_vbsFEReadFilesOfFolder" script reads the files from the specified 
path and shows them as a table. 

LHmiView_vbsFERename 

The "LHmiView_vbsFERename" script renames the selected file/folder.  

LHmiView_vbsFESearch 

The "LHmiView_vbsFESearch" script searches for the specified file / folder in the 
current path. 

LHmiView_vbsFEShowFiles 

The "LHmiView_vbsFEShowFiles" script opens the selected folder / file. 

LHmiView_vbsFEWriteFilePropertiesToTags 

The "LHmiView_vbsFEWriteFilePropertiesToTags" script writes the properties of 
the selected folder / file to the associated HMI tags. 
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25.2 Integration into the user project 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiView > 
FileExplorer" of the library. 

3. Drag the elements (Template, Screens, Scripts, Tag table) to the 
corresponding folder of the operator panel. 

Figure 25-2 

 

 

Note 

Depending on the size of the HMI operator panel, it may be necessary to adapt 
the screens. 

4. Drag the "btnFileExplorer" button from the library to your screen. You call the 
File Explorer via this button. 

5. Open the properties of the "LHmiView_FileExplorer" screen. 
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6. Add the scripts "LHmiOper_vbsFEReadFilesOfFolder" and 
"LHmiOper_vbsFeWriteFilePropertiesToTags" (4) to the "Loaded" event of the 
screen. 

Select the tags "Folder" and "index" as transfer parameters "folderpar" and 
"index". 

Figure 25-3 

 

 

7. Download the visualization to your operator panel or simulate it. 

 

 

  

Note The File Explorer gives the operator access to all files of the operator panel. 
Therefore, use appropriate operator authorizations to protect the File Explorer. 

The File Explorer works on a panel operating system as well as on  
WinCC RT Advanced. 
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25.3 Operation 

Note The operation is explained with the help of the example project. When you use 
the tool in your own configuration, the call may be somewhat different. 

The basic functionalities are not affected by this. 

 

1. Open the visualization on your operator panel. 

2. Open the Tools overview and click on the  
"File explorer" button. The screen with the File Explorer opens.  

The default path setting is "\" ("My Computer" – Windows CE) or "C:\" 
(Computer – Windows).  

Figure 25-4 

 

Note 

Due to the space requirements on the operator panel, very long path names 
will not be displayed (approx. 60 or more characters). If you regularly use 
longer path names, resize the file browser and the I/O fields to suit your 
requirements. 
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3. Select a folder (1) and open it with the Open button (2). 

Figure 25-5 

 

 

4. Create a new folder (1) in the current directory with the New button. The pop-
up screen "Add new folder" opens. 

Enter a folder name of your choice (2) and add it with the "ADD" button (3). 
Close the pop-up screen with the "CANCEL" button without creating a new 
folder. 

Figure 25-6 
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Result 

A new folder is created and shown in the table. 

Figure 25-7 

 

 

5. Select the folder in the table and click the Rename button (2). The pop-up 
screen "Rename file / folder" opens. 

Enter a new name of your choice (2) and rename the folder with the 
"RENAME" button (3). Close the pop-up screen with the "CANCEL" button 
without renaming the file / folder. 

Figure 25-8 
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Result 
The folder name is changes and is shown in the table. 

Figure 25-9 

 

 

6. Select the folder in the table (1). Use the copy button to copy the folder to the 
clipboard (2). 

Figure 25-10 
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7. You use the Back button (1) to move up one folder level. You use the paste 
button to paste the copy of the folder (2).  

 
Result 
The folder is copied to the selected directory. 

Figure 25-11 

 

 

8. Select the folder in the table. Use the delete button to delete the folder (1). The 
pop-up screen "Delete file / folder" opens. 

Confirm the deletion with the "APPLY" button (2). Close the pop-up screen with 
the "CANCEL" button without deleting the file / folder. 

Figure 25-12 

 

Note 

Only folders without content can be deleted. Delete all files in the folder prior to 
deletion. 
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Result: The folder is deleted. 

Figure 25-13 

 

 

9. Navigate to a folder of your choice (1) and select a file that you want to move. 

Use the cut button (2) to cut the file and copy it to the clipboard. 

Figure 25-14 
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10. Navigate to a folder of your choice and press the paste button (1).  

 
Result: The file is pasted under the selected folder path (2). 

Figure 25-15 

2

 

11. Press the "X" button to close the File Explorer. 

Figure 25-16 

 

12. Use the Back button in the status bar to return to the previous screen. 
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26 Increase clarity – Table view for logs 

26.1 General description 

Logs allow you to back up tags and alarms during runtime. The alarm view allows 
you to output the alarm logs, and the trend view allows you to output the tag logs.  

The "Table view" allows you to display tag logs on the HMI operator panel also as 
tables. 

Figure 26-1 

 

 

Plus the tool lets you filter the tag log using specific criteria. 

Figure 26-2 
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26.1.1 Hardware and software components 

This application example is valid for: 

• WinCC Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels,  
Mobile Panels 2nd Generation 

• SIMATIC WinCC RT Advanced V15.1 

 

26.1.2 VBS scripts used 

This section explains the functions of the scripts used in the tool. 

LHmiView_vbsRead ArchiveToHmiTags 

The "LHmiView_vbsRead ArchiveToHmiTags" script reads the entries of the read 
tag log, writes the information to HMI tags and displays them in a table. 

LHmiView_vbsFormatArchiveFile 

The "LHmiView_vbsFormatArchiveFile" script sorts the entries of the read tag log. 

LHmiView_vbsFilterArchiveTableView 

The "LHmiView_vbsRead ArchiveToHmiTags" script filters the entries of the read 
tag log by the specified filter criterion, writes the information to HMI tags and 
displays them in a table. 
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26.2 Integration into the user project 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiView > 
TableView" of the library. 

3. Drag the elements (Template, Screen, Scripts, Tag table) to the corresponding 
folder of the operator panel. 

Figure 26-3 

 

Note 

Depending on the size of the HMI operator panel, it may be necessary to adapt 
the screens. 
 

4. Drag the "btnArchiveTableView" button from the library to a screen of your 
choice. You open the tool with this button. 

5. Download the visualization to your operator panel or simulate it. 
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26.3 Operation 

Note The operation is explained with the help of the example project. When you use 
the tool in your own configuration, the call may be somewhat different. 

The basic functionalities are not affected by this. 

You need a log file for testing. 

 

1. Open the visualization on your operator panel. 

2. Open the Tools overview and click on the "Table view" button. The screen with 
the tool opens.  

3. Open the File Explorer with the "OPEN" button.  
The File Explorer opens. 

Figure 26-4 

 

 

4. Select a log file of your choice that you want to display (1). 

Confirm the selection with "OK" (2). The log is displayed as a table. 

Figure 26-5 
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Note 

Depending on the hardware used, the call of large logs may take some time. 
 

5. You scroll through the table entries with the scroll bar on the right next to the 
table. Scrolling is per page (5 entries per page). 

Figure 26-6 

 

6. Enter a filter text for the tag name in the I/O field and confirm the entry with the 
RETURN button of the on-screen keyboard.  
The table now only shows entries that match the filter text completely. 

Figure 26-7 

 

Note 
Please note that the input is case-sensitive. 
 

7. Press the Back button to delete the filter text.  
The table now shows the entire log again. 
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27 Increase clarity – Changing the 
background when calling pop-up screens 

27.1 General description 

The options for using pop-up screens are multifold. They are frequently used for 
input of specific machine parameters or as query / acknowledgment dialog. 

It is therefore important to shift the focus of the operator to the pop-up screen (by 
making the background darker or brighter) and limit an operation of screen objects 
in the background of the pop-up screen. 

To accomplish this goal, the tool uses a button with a graphic that is partially 
transparent which is added to the screen. After activation of the pop-up screen, the 
graphic is made visible by means of an HMI tag. The graphic is hidden once again 
after deactivating the pop-up screen. 

 

Figure 27-1 

 

 

27.1.1 Hardware and software components 

This application example is valid for:  

• SIMATIC WinCC Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels,  
Mobile Panels 2nd Generation 

• SIMATIC WinCC RT Advanced V15.1 

  



27 Increase clarity – Changing the background when calling pop-up screens 

 

Toolbox für HMI-Projekte 
Entry ID: 106226404,    V5.0,    02/2019   186 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

27.2 Integration into the user project 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiView > 
ChangeBackground" of the library. 

3. Drag the elements (Tag table) to the corresponding folder of the operator 
panel. 

Figure 27-2 

 

Note 
The library also contains the template "TemplateGeneralStatusBar", the screen 
"LHmiView_ChangeBackground", the pop-up screen 
"LHmiView_popupChangeBackground" as well as the "btnChangeBackground" 
button for calling the screen.  

They are needed for the example project and are not part of the tool. 

4. Open the screen by changing the background when calling a pop-up screen 
and limiting the operability of the screen objects. 

5. Drag and drop one of the buttons with partially transparent graphic from the 
library to your screen. 

– Dark background – "btnDarkBackground" 

– Light background – "btnLightBackground" 
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6. Select the button and open the associated properties for the layout. Adjust the 
width and height to the overall size of your screen. 

Figure 27-3 

 

7. Open your pop-up screen. 

8. Open the results of your pop-up screen.  

9. Add the system function "SetBit" to the "Loaded" event. For the transfer 
parameter "Tag (Input/output)", select the tag for visibility 
"LHmiView_ActivatePopUpBackground". 

Figure 27-4 

 

 

10. Add the system function "ResetBit" to the "Cleared" event. For the transfer 
parameter "Tag (Input/output)", select the tag for visibility 
"LHmiView_ActivatePopUpBackground". 

Figure 27-5 

 

 

11. Download the visualization to your operator panel or simulate it. 
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27.3 Operation 

Note The operation is explained with the help of the example project. When you use 
the tool in your own configuration, the call may be somewhat different. 

The basic functionalities are not affected by this. 

 

1. Open the visualization on your operator panel. 

2. Open the Tools overview and click on the "Change Background" button.  

3. Press the "Open Pop-up screen" button. The background turns dark and the 
"Changing Background" pop-up screen opens. 

Figure 27-6 

 

 

4. Close the pop-up screen with the "CANCEL" button. The screen turns bright 
again. 
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28 Increase clarity – Waiting view 

28.1 General description 

The waiting view allows you to inform the operator when a function (e.g. script 
execution) still needs time. This also prevents operator errors.  

Three versions of the waiting view are available. 

Circle – Graphic I/O field with "gfxioWaitingViewCircle" graphics list 

Figure 28-1 

 

 

Rectangles – "WaitingViewRectangles" screen object group 

Figure 28-2 
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Writing – "WaitingViewText" screen object group 

Figure 28-3 

 

 

28.1.1 Hardware and software components 

This application example is valid for: 

• SIMATIC WinCC Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels,  
Mobile Panels 2nd Generation 

• SIMATIC WinCC RT Advanced V15.1 
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28.2 Integration into the user project 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiView > 
WaitingView" of the library. 

3. Drag the tag table to the corresponding folder of the operator panel. 

Figure 28-4 

 

Note 
The library also contains the template "TemplateWaitingView", the screens 
"LHmiView_WaitingViewCircle", "LHmiView_WaitingViewRectangles", 
"LHmiView_WaitingViewText" as well as the "btnWaitingView" button for calling 
the "LHmiView_WaitingViewCircle" screen.  

They are needed for the example project and are not part of the tool. 

 

4. Open a screen of your choice. Drag and drop a waiting view of your choice 
from the library to your screen. 

5. Only when using the "LHmiView_waitingAnimation" waiting view  

Open the general properties of the "gfxioWaitingViewCircle" graphic view. 
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Add the tag "LHmiView_waitingAnimation" as process value for simulation of 
the graphics list. 

Figure 28-5 

 

Note 

Step 5 is not necessary for the other versions. 

 

6. Open the events of your screen.  

7. Add the system function "SetBit" to the "Loaded" event.  

Select the tag "LHmiView_WaitingActive" as transfer parameter. It controls the 
visibility of the waiting view. The waiting view will be visible after setting up the 
screen. 

Figure 28-6 

 

Note 
Use the tag "LHmiView_WaitingActive" to make the waiting view visible and 
invisible. 

– 1: visible 

– 0: invisible 

8. Add the system function "SimulateTag" to the "Loaded" event with the 
parameters from Figure 28-7.  

Select the tag "LHmiView_waitingAnimation" as transfer parameter. The 
animation of the waiting view is controlled with the value (value range 1-15) of 
the tag. 

Figure 28-7 
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9. Add the system function "ResetBit" to the "Cleared" event.  

Select the tag for visibility "LHmiView_WaitingActive" for the transfer 
parameter. The waiting view will be invisible after taking down the screen. 

Figure 28-8 

 

 

10. Download the visualization to your operator panel or simulate it. 
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28.3 Operation 

Note The operation is explained with the help of the example project. When you use 
the tool in your own configuration, the call may be somewhat different. 

The basic functionalities are not affected by this. 

 

1. Open the visualization on your operator panel. 

2. Open the Tools overview and click on the "Waiting view" button. The screen 
with the "Circle" waiting view opens. The circle is filled and emptied in 
clockwise direction. 

Figure 28-9 

 

 

3. Open the screen with the "Rectangles" waiting view using the "Waiting view – 
Rectangles" button in the page navigation on the left. The blue rectangles are 
filled in clockwise direction. 

Figure 28-10 
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4. Open the screen with the "Text" waiting view using the "Waiting view – Text" 
button in the page navigation on the left. The three loading dots are visible one 
after the other.  

Figure 28-11 
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29 Increase clarity – Percentage view 

29.1 General description 

The percentage view allows you to show integer percentage values (0% to 100%). 
Use this feature to present the plant operator with a clearly organized overview, for 
example, of progress in production, KPIs or fill levels. 

You can use the two versions (circle or ring) of the percentage view. The 
percentage views are available as the faceplates through the library for integration 
into your project. The individual parameter setting is done through the interfaces of 
the faceplates. 

Circle – "LHmiView_fpCirclePercentageView" 

 Figure 29-1 

 

 

Ring – "LHmiView_fpRingPercentageView" 

Figure 29-2 
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29.1.1 Hardware and software components 

This application example is valid for:  

• SIMATIC WinCC Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels,  
Mobile Panels 2nd Generation 

• SIMATIC WinCC RT Advanced V15.1 
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29.2 Integration into the user project 

1. Open your WinCC configuration and the library with the tools (Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiView > 
PercentageView" of the library. 

3. Drag the tag table to the corresponding folder of the operator panel. 

Figure 29-3 

 

Note 

The library also contains the template "TemplatePercentageView", the screens 
"LHmiView_PercentageViewCircle", "LHmiView_PercentageViewRing" as well 
as the "btnPercentageView" button for calling the 
"LHmiView_PercentageViewCircle" screen.  

They are needed for the example project and are not part of the tool. 

In the application example the tag "LHmiView_percentage" is simulated with 
the system function "Simulate tag" from 0 to 100. The value changes every 
second by 1. The system function is connected to the call of the screens. 
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4. Open the folder "Types > 03_Tools > 03_Faceplates > LHmiView> 
PercentageView" of the library. 

Figure 29-4 

 

 

5. Open a screen and copy the desired faceplate to your screen with drag and 
drop. The faceplate is automatically copied to your project library. 

6. Select the faceplate and open the interface of the faceplate under "Properties > 
Interface". 

Connect your tag for the percentage value (data type: INT) to the properties of 
the "Values" category.  

Figure 29-5 
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7. Optional 
In the properties of the "Design" category, specify the style of the I/O field and 
of the background (only for percentage view "Ring").  

Figure 29-6 

 

8. Download the software to your operator panel or start the simulation. 
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29.3 Operation 

Note The operation is explained with the help of the example project. When you use 
the tool in your own configuration, the call may be somewhat different. 

The basic functionalities are not affected by this. 

 

1. Open the visualization on your operator panel. 

2. Open the Tools overview and click on the "Percentage view" button. The 
screen with the "Circle" percentage view opens.  

Result  
The circle fills up in clockwise direction and the current percentage value is 
displayed in the I/O field. 

Figure 29-7 
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3. Open the screen with the "Ring" percentage value using the "Percentage view 
– Ring" button in the page navigation on the left.  

Result  
The ring fills up in clockwise direction and the current percentage value is 
displayed in the I/O field. 

Figure 29-8 
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30 Increase clarity – Bit monitor 

30.1 General description 

The bit monitor allows you to visualize positive, integer HMI tags (USINT - Byte, 
UINT - Word, UDINT - Double) bit by bit. This is particularly useful during 
commissioning and when analyzing error states. 

The bit views are available as faceplates for 8-bit (data type: USINT), 16-bit (data 
type: UINT) and 32-bit tags (data type: UDINT) and can be used independent of 
one another. 

The HMI tag to be displayed is simply connected over the respective interface of 
the faceplate. The bit structures of the individual data types are available for further 
processing at the interface over HMI tags. 

• "LHmiView_byteStructure" tag, UDT: LHmiView_typeByteBitMonitor 

• "LHmiView_wordStructure" tag, UDT: LHmiView_typeWordBitMonitor 

• "LHmiView_doubleStructure" tag, UDT: LHmiView_typeDoubleBitMonitor 

 

An internal faceplate script masks the individual bits. 

 

Bit monitor data type "Byte" 

Figure 30-1 
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Bit monitor data type "Word" 

Figure 30-2 

 

 

Bit monitor data type "Double" 

Figure 30-3 

 

 

30.1.1 Hardware and software components 

This application example is valid for:  

• SIMATIC WinCC Comfort / Advanced V15.1 

• SIMATIC Comfort Panels, Comfort PRO Panels, Outdoor Panels,  
Mobile Panels 2nd Generation 

• SIMATIC WinCC RT Advanced V15.1 
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30.2 Integration into the user project 

1. Open your WinCC configuration and the library with the tools.  
(Section 2.3). 

2. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiView > 
BitMonitor" of the library. 

3. Drag the elements (Tag table) to the corresponding folder of the operator 
panel. 

Figure 30-4 

 

Note 

The library also contains the template "TemplateBitMonitor", the screens 
"LHmiView_BitMonitorByte", "LHmiView_BitMonitorWord", 
"LHmiView_BitMonitorDouble", as well as the "btnBitMonitor" button for calling the 
"BitMonitorByte" screen.  

They are needed for the example project and are not part of the tool. 

In the application example the internal tags "LHmiView_byteTag", "LHmiView_wordTag" 
and "LHmiView_doubleTag" are displayed via the bit monitor. The value is changed 
through an associated I/O field. 
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4. Open the folder "Types > 03_Tools > 03_Faceplates > LHmiView> BitMonitor" 
of the library. 

Figure 30-5 

 

5. Open a screen and drag and drop a bit monitor of your choice to your screen. 
The faceplate is automatically copied to your project library. 

6. Select the faceplate and open the interface of the faceplate. 

Connect your tags for the process value (data type: USINT/UINT/UDINT) for 
the bit structure and the faceplate visibility to the properties of the "Values" 
category.  

Figure 30-6 
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7. Optional 
In the properties of the "Design" category, specify the style of the screen 
objects in the faceplate.  

Figure 30-7 

 

8. Download the software to your operator panel or start the simulation. 
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30.3 Operation 

Note The operation is explained with the help of the example project. When you use 
the tool in your own configuration, the call may be somewhat different. 

The basic functionalities are not affected by this. 

 

1. Open the visualization on your operator panel. 

2. Open the Tools overview and click on the "Bit monitor" button. The screen with 
the "Byte" bit monitor opens. 

3. Enter a value of your choice (2). The individual bits have a green background 
in the bit monitor (3). 

Figure 30-8 

3
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4. Open the screen with the "Word" bit monitor using the "Bit monitor – Word 
(UINT) - 16 Bit" button in the page navigation on the left (1). 

Enter a value of your choice (2). The individual bits have a green background 
in the bit monitor (3). 

Figure 30-9 

3

 

 

5. Open the screen with the "Double" bit monitor using the "Bit monitor – Double 
(UDINT) - 32 Bit" button in the page navigation on the left (1). 

Enter a value of your choice (2). The individual bits have a green background 
in the bit monitor (3). 

Figure 30-10 

3
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31 Simplified engineering – Rotation Tool 

31.1 General description 

In addition to color, motion is a good medium to simply and clearly illustrate the 
status of a machine, for example. It can, for example, be used to illustrate pumps, 
fans, motors, mixers, or gears. 

The "Rotation Tool" is a Microsoft PowerPoint Add-In that you can use to 
automatically rotate and save screens in different status conditions as a "*.png" file. 
The tool is operated over its own dialog window. 

Figure 31-1 

 

Optionally, you can directly create an "*.xml" file which you can import as a 
graphics list directly into the HMI project using TIA Portal Openness. 

The gauge controls for Basic Panels (section 23) were also created using the 
Rotation Tool. 

 

31.1.1 Principle of operation 

Figure 31-2 

Microsoft

PowerPoint

TIA Portal

Erstellung eines grafischen E/A-Feldes 

aus Grafikliste und Steuervariable

PNG-Grafiken
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janein
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31.1.2 Hardware and software components 

This application example is valid for: 

• Microsoft PowerPoint 2010 

• SIMATIC WinCC Basic / Comfort / Advanced V13 SP1 and higher  

• SIMATIC Basic / Comfort Panels, Comfort PRO Panels, Outdoor Panels, 
Mobile Panels 2nd Generation 

• SIMATIC WinCC RT Advanced V13 SP1 and higher 

• Optional: SIMATIC TIA Portal Openness V13 SP1 

 

31.2 Installation 

1. Download the file "Rotation_tool.zip" and unzip the folder. 

2. Open Microsoft PowerPoint. Click on "Developer". 
If the "Developer" tab is not displayed, you must first make it visible (see 
Microsoft Office Support entry). 

3. Click on "Visual Basic". 

Figure 31-3 

 

4. Under "Options > References", enable the references "Visual Basic For 
Applications", "Microsoft PowerPoint Object Library" and "Microsoft Forms 
Object Library". 

5. Confirm the dialog with the "OK" button. 

6. Click on "Add-ins".  

Figure 31-4 

 

7. Click "Add new ...". 

8. Select the "HMI_GraphicList_Designer.ppa" file in the unzipped folder and 
confirm your selection with "Open". 

9. Confirm the security prompt with "Enable macros". 

10. Close the "Add-ins" window. 

https://support.office.com/en-us/article/show-the-developer-tab-e1192344-5e56-4d45-931b-e5fd9bea2d45?ui=en-US&rs=en-US&ad=US
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31.3 Operation 

1. Create a new PowerPoint presentation with a slide. 
Add the desired screen elements. 

2. Add a rectangle as background to the slide. Select "Shape Fill > No Fill" and 
"Shape Outline > No Outline".  

Note 
Make sure that the selected rectangle is big enough to completely house the 
rotating objects in any position. As a result, all screens are saved in the same 
size. 
Note that circles, too, have a rectangular frame in PowerPoint so that they are 
displayed wider during rotating. 

Figure 31-5 

 

3. Click on "Add-Ins > HMI GraphicList Designer > Rotation" to start the tool. 

Figure 31-6 

 

4. Select the following parameters in the "Settings" window: The  

– Direction of rotation  

– Angle of rotation 

– Number of intermediate steps of the rotation or size of the angle of an 
intermediate step using the selection list 

Figure 31-7 

 

5. In the "Select" window, select the objects you wish to rotate and click the ">" 
arrow. 
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Figure 31-8 

 

6. In the "Run" window check if a graphics list shall be created as an "*.xml" file 
(for import with "TIA Portal Openness"). 

7. Open your TIA Portal project.  

8. In the project tree, open "Languages & Resources > Graphics library". 

9. Drag and drop the screens from the Explorer to the graphics library. 

 

Importing the graphics via TIA Portal Openness 

1. Download the "TiaPortalOpennessDemo" demo application from entry id 
108716692. 
If you do not yet use TIA Portal Openness, download the documentation and 
install TIA Portal Openness as described. 

2. Link the application with the project and import the graphics list as described in 
the documentation. 

Manual import 

1. Create a new graphics list in your HMI operator panel. 

2. Insert the screens from the graphics library into the graphics list and adapt the 
values. 

3. Create a new screen in your operator panel. Add a graphic I/O field. 

4. Under "Properties > Properties > General > Contents > Graphics list:" connect 
the related graphics list. 

5. Specify the associated process tag under "Process > Tag:". 

 

https://support.industry.siemens.com/cs/de/de/view/108716692
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31.4 Tips and tricks 

31.4.1 Determining the start position 

The Rotation Tool changes the "Rotation" property of a screen object. 
Before the first screen is created, the "Rotation" value of any rotating element is set 
to 0°. 

If a rotating element is to start at an angle other than 0°, right-click the element in 
the desired start position and click "Save as graphic...". Save the element in PNG 
format. Then insert the element as a graphic into the PowerPoint screen again. 

 

31.4.2 Setting the rotation axis 

The elements selected in the tool rotate through their center point. To choose 
another rotation axis, it is useful to group the desired element with a hidden 
element and then select the entire group for rotation. 

 

Figure 31-9 

 

 

31.4.3 Continuous rotation 

The tool creates in a first step a screen at a 0° rotation (initial state). 

A rotation of 360° corresponds to 0°. For a graphic intended to continuously rotate 
through its own axis you should consider that the last intermediate step must be 
dropped to prevent two identical screens from following one another.  

One way to achieve this is by skipping the graphics list element 0 or 100 when 
triggering via the control tag (e.g. "startValue" =1).  
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Alternatively, subtract the angle size of an intermediate step from the overall 
rotation angle to be able to select a step number reduced by 1 in the Rotation Tool.  

Figure 31-10 

 

 

 

31.4.4 Creating the control tag 

If you intend not to display a real rotation of one of the objects contained in your 
process with the rotating object but simulate the rotation, you must create the 
control tag manually. 

To do so you can use, for example, the "SimulateTag" system function at the 
"Loaded" event of the screen. In this case the object will always rotate when the 
screen is displayed. 

If you want to also start and stop the rotation, you can use the STEP 7 function 
"LGF_SawTooth" (more information is available in the documentation list \3\). 
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32 Simplified engineering – Siemens icon font 

32.1 General description 

Siemens provides you with a font containing a large selection of icons that you can 
use as text, for example, for buttons.  
In addition to the icons the font also contains a normal character set. This character 
set corresponds to the character set of the "Siemens Sans" font. 

The documentation gives you a clear overview about available icons and shows 
you how to integrate such icons into your own project. 

The attached download file "106226404_SiemensIconFont.zip" contains the 
"SiemensTIAPortalIcons.ttf" font. 

In the example project, the icons are used as text on the buttons, and a color 
switching is used as example to show you how you can make use of the diverse 
dynamic sampling options. 
 

Figure 32-1 

 

 

32.1.1 Advantages through the use of icons 

• Easy multilingual engineering 
You can use the icons in any language as they are understood without 
translation. For other languages, just copy the text list of the language you 
have already parametrized.  

• Free scaling 
Characters are freely scalable. Unlike with graphics, you must not pay attention 
to the size or the resolution of the source material. Free scaling avoids possible 
built-up of artefacts / blurring effects when zooming in on / zooming out of 
screens. 

• Automatic transparency 
Icon characters of the font have a transparent background. You must not pay 
attention to set the background transparent or color it according to the project 
color.  
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32.1.2 Hardware and software components 

This application example is valid for: 

• SIMATIC WinCC Basic / Comfort / Advanced V15.1 

• SIMATIC Basic / Comfort Panels, Comfort PRO Panels, Outdoor Panels, 
Mobile Panels 2nd Generation 

• SIMATIC WinCC RT Advanced V15.1 

 

32.1.3 Available icons 

The "Siemens TIA Portal Icons Standard" font includes a large selection of icons 
which are shown in the table below. 

Note The ASCII characters 61824 to 61857 are supported in WinCC Professional only  
as of TIA V14 SP1. 

 

Table 32-1 

HEX ASCII Character HEX ASCII Character HEX ASCII Character 

F101 61697  F102 61698  F103 61699  
F104 61700  F105 61701  F106 61702  
F107 61703  F108 61704  F109 61705  
F10A 61706  F10B 61707  F10C 61708  
F10D 61709  F10E 61710  F10F 61711  
F110 61712  F111 61713  F112 61714  
F113 61715  F114 61716  F115 61717  
F116 61718  F117 61719  F118 61720  
F119 61721  F11A 61722  F11B 61723  
F11C 61724  F11D 61725  F11E 61726  
F11F 61727  F120 61728  F121 61729  
F122 61730  F123 61731  F124 61732  
F125 61733  F126 61734  F127 61735  
F128 61736  F129 61737  F12A 61738  
F12B 61739  F12C 61740  F12D 61741  
F12E 61742  F12F 61743  F130 61744  
F131 61745  F132 61746  F133 61747  
F134 61748  F135 61749  F136 61750  
F137 61751  F138 61752  F139 61753  
F13A 61754  F13B 61755  F13C 61756  
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HEX ASCII Character HEX ASCII Character HEX ASCII Character 

F13D 61757  F13E 61758  F13F 61759  
F140 61760  F141 61761  F142 61762  
F143 61763  F144 61764  F145 61765  
F146 61766  F147 61767  F148 61768  
F149 61769  F14A 61770  F14B 61771  
F14C 61772  F14D 61773  F14E 61774  
F14F 61775  F150 61776  F151 61777  
F152 61778  F153 61779  F154 61780  
F155 61781  F156 61782  F157 61783  
F158 61784  F159 61785  F15A 61786  
F15B 61787  F15C 61788  F15D 61789  
F15E 61790  F15F 61791  F160 61792  
F161 61793  F162 61794  F163 61795  
F164 61796  F165 61797  F166 61798  
F167 61799  F168 61800  F169 61801  
F16A 61802  F16B 61803  F16C 61804  
F16D 61805  F16E 61806  F16F 61807  
F170 61808  F171 61809  F172 61810  
F173 61811  F174 61812  F175 61813  
F176 61814  F177 61815  F178 61816  
F179 61817  F17A 61818  F17B 61819  
F17C 61820  F17D 61821  F17E 61822  
F17F 61823  F180 61824  F181 61825  
F182 61826  F183 61827  F184 61828  
F185 61829  F186 61830  F187 61831  
F188 61832  F189 61833  F18A 61834  
F18B 61835  F18C 61836  F18D 61837  
F18E 61838  F18F 61839  F190 61840  
F191 61841  F192 61842  F193 61843  
F194 61844  F195 61845  F196 61846  
F197 61847  F198 61848  F199 61849  
F19A 61850  F19B 61851  F19C 61852  
F19D 61853  F19E 61854  F19F 61855  
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HEX ASCII Character HEX ASCII Character HEX ASCII Character 

F1A0 61856  F1A1 61857     
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32.2 Installing the font 

32.2.1 Installation in Windows 

There are three options to install the font in Windows.  

Download the font on the entry page and unzip the 
"106226404_SiemensIconFont.zip" file into a folder of your choice for installation. 
The "SiemensTIAPortalIcons.ttf" file contains the "Siemens TIA Portal Icons 
Standard" font. 

 

Note Close all instances of the TIA Portal prior to the installation.  

If an instance of the TIA Portal was open during the installation of the font, close 
the TIA Portal and then restart it. 

Option 1 

1. Double-click the "SiemensTIAPortalIcons.ttf" file to open it. The font preview 
opens. 

2. Click "Install".  

Figure 32-2 

 

Note 
You need to have the required administrator rights to do this. 

Option 2 

1. Right-click the "SiemensTIAPortalIcons.ttf" file. The shortcut menu opens. 

Click "Install". 
 

Figure 32-3 

  
Note 
You need to have the required administrator rights to do this. 
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Option 3 

1. Select the file "SiemensTIAPortalIcons.ttf" and copy the file using the key 
combination <Ctrl> + <C>. 

2. Open the "Fonts" folder in the Control Panel. 

3. Add the "SiemensTIAPortalIcons.ttf" file with the key combination <Ctrl> + <V>. 

 

32.2.2 Installation on Basic / Comfort Panels 

Automatic transfer by downloading the configuration 

The font is transferred to the panel along with the project and therefore must not be 
installed on the panel manually. The project contains the necessary data during 
download to the operator panel. 

The font is not saved in the font folder of the HMI operator panel. This means that 
the font is not recognized on the HMI operator panel outside of Runtime. 

 

Note The font is not saved in the font folder of the HMI operator panel. This means 
that the font is not recognized on the HMI operator panel outside of Runtime. 

Manual installation (optional) 

If you want to use the font outside of Runtime, for example, display a Word file with 
characters of this font on the operator panel, install the font manually. 

1. Copy the "SiemensTIAPortalIcons.ttf" to a storage medium of your choice and 
connect it with your HMI operator panel. 

2. Open the Explorer via "Desktop > My Computer". 

3. Go to your storage medium and copy the "SiemensTIAPortalIcons.ttf" file. 

4. Open the "Windows > Font" folder. 

5. Add the "SiemensTIAPortalIcons.ttf" file to the "Fonts" folder. 

 

Note The installed font is only available for a few specific applications.  

Under Windows CE ("Panels operating system"), you cannot change the system 
font. 
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32.3 Integration into the user project 

32.3.1 Integrating the font into your project 

Note When you configure a PC station with SIMATIC WinCC RT Advanced, you do 
not have to integrate the font. You only have to install the font. All installed fonts 
of the Windows operating system are available for the configuration. 

 

To use the "Siemens TIA Portal Icons" font, integrate it as configured font into your 
HMI project. 

1. Open the folder of your operator panel in the project tree. 

2. Open the "Runtime settings" with a double-click. 

3. Select "Language & font". 

4. Select the cell under "Configured font 1". 

5. Click on the selection icon and select the  
"Siemens TIA Portal Icons" font from the selection list.  

6. If necessary, apply the settings for additional configured languages. 

Figure 32-4

  

 

Note With Basic Panels you can configure your own "Configured font 1" in addition to 
the system font. 

With other Panels you can configure up to two separate fonts "Configured font 1" 
and "Configured font 2" in addition to the system font. 

 



32 Simplified engineering – Siemens icon font 

 

Toolbox für HMI-Projekte 
Entry ID: 106226404,    V5.0,    02/2019   223 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

32.3.2 Using the font 

Setting the font, font style and font size 

You have to manually customize the font, as well as associated font style and font 
size for basic objects and elements. 

1. Select the basic object or element in which the symbol is to be displayed. 

2. Click on "Properties > Text format". 

3. In "Format > Font", click the "…" button. 

4. Select the "Siemens TIA Portal Icons" font and make the desired settings for 
"Font style" and "Size". 

5. Click on "OK". 

 

Text input of the icon 

1. Select the basic object or element in which the symbol is to be displayed. 

2. Click on "Properties > General". 

Note 

Make sure that "Text" or "Graphics and text" is selected as mode under 
"Buttons". 

3. Click in the input box for the text input. 

4. Press and hold the <Alt> key and enter the "ASCII" character code of the icon 
(see Table 32-1). 

5. Release the <Alt> key. 

6. Press "Enter" or click an area outside of the "General" window. The icon 
appears as text of the object. 
The icon is not displayed in the input area of the "General" window. A square 
indicates that the input was successful.  
 
Note 
An input error has occurred or an incorrect "ASCII" code was entered if no text, 
a question mark or an unexpected icon appears in the input field.  

Solution: Erase the text and repeat the input. 
 

Note The sequence of the steps "Setting of font, font style and font size" and "Text 
input of the icon" can be changed. However, the specified sequence is 
recommended. 

The font can also be used when entering text in text lists. Input takes place as 
described above. 

You can write several icons one after the other just like text characters. Simply 
repeat the input.  

A combination of symbol and text is also possible. The font size depends on the 
default text format of the basic object or element. 

Positioning the icons  

Under "Properties > Text format > Alignment" you can set the general horizontal 
and vertical alignment of the font. 

Follow the description below to more accurately position the icon on the basic 
object or element. 
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1. Select the basic object or element with the icon. 

2. Click on "Properties > Layout". 

3. Enter the desired margins under "Text margins". 

 

Multilingual configuration of icons 

1. Open the "Languages & resources > Project texts" folder in the project tree. 

2. Scroll down; the symbols and special characters are at the end of the list and 
can be identified by the square character (in standard sorting). 

3. Select all icons.  
Select the first entry and scroll down to the last entry. Keep the <Shift> key 
pressed and select the last entry. 

4. Copy the selected area. Scroll to the first icon entry. 

5. Next to the first icon entry, click the cell of another configured language. Paste 
the copied area. 

6. Repeat the last item for each configured language. 

 

Transferring the font style to other objects 

Within a screen, you can assign the same font style to several objects all at once.  

1. Draw a frame around the desired objects or click a single object. To 
interconnect several selections, press and hold the <Shift> key and draw 
additional frames or select additional single objects.  

2. To remove an object from the selection, keep holding down  
the <Shift> key and click the object you wish to remove from the selection. 

3. Release the <Shift> key and click "Properties". 

Assign the font and the font style as described in the chapter "Setting the font, 
font style and font size". 

If the desired target objects are not in the same screen, you can copy the set 
font style and paste it into the desired object. 

4. In the "Text format" window, right-click the font and select "Copy" (or select the 
entry and use the shortcut <Ctrl>+<C>). 

5. Select the desired object and select the available font in the "Text format" 
window.  

6. Right-click the selected area and select "Paste" (or use the shortcut 
<Ctrl>+<V>). 

Note 

You can also copy an object for which you have already set the font and the 
style. The properties are retained in the process. 

 

32.3.3 Integrating the example configuration 

1. Open your WinCC configuration and the library with the tools.  
(Section 2.3). 

2. Integrate the font as described in section 32.3.1. 

3. Open the folder "Master copies > 02_HMI > 03_Tools > LHmiEng > IconFont" 
of the library. 



32 Simplified engineering – Siemens icon font 

 

Toolbox für HMI-Projekte 
Entry ID: 106226404,    V5.0,    02/2019   225 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

4. Drag the elements (Template, Screens, Tag table) to the corresponding folder 
of the operator panel. 

Figure 32-5 

 

Note 

Depending on the size of the HMI operator panel, it may be necessary to adapt 
the screens. 
 

5. Drag the "btnSiemensIconFont" button from the library to your screen. You use 
this button to open the "LHmiEng_IconFontPage1" screen. 

6. Download the software to your operator panel or start the simulation. 

 

32.4 Operating the example configuration 

Note The potential uses of the font are shown using the example project. When you 
use the tool in your own configuration, the use of the font may be somewhat 
different. 

 

1. Open the visualization on your operator panel or your simulation. 

2. Open the Tools overview and click on the "Icon font" button. The screen with 
the first 30 icon buttons opens. 
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3. Use the arrow keys to switch between the screens. You will see various 
screens with buttons on which potential icons are shown. 

Figure 32-6 

 

4. Change the icon color to a color of your choice by using the color buttons. The 
color changes for all icons. 

Figure 32-7 
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5. Let the icons flash. Click on a button of your choice. 

Figure 32-8 
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33 Appendix 

33.1 Service and Support  

Industry Online Support 

Do you have any questions or need assistance?  

Siemens Industry Online Support offers round the clock access to our entire 
service and support know-how and portfolio.  

The Industry Online Support is the central address for information about our 
products, solutions and services.  

Product information, manuals, downloads, FAQs and application examples – all 
information is accessible with just a few mouse clicks at:  
https://support.industry.siemens.com/ 
 

Technical Support 

The Technical Support of Siemens Industry provides you fast and competent 
support regarding all technical queries with numerous tailor-made offers 
– ranging from basic support to individual support contracts. 

You can send questions to Technical Support via the web form at:  
https://www.siemens.com/industry/supportrequest 
 

SITRAIN – Training for Industry 

With our globally available training courses for Siemens products and solutions, we 
support you in step with actual practice, with innovative learning methods and with 
a customized training concept.  

You can find out more about the training courses offered as well as their locations 
and dates at:  
https://www.siemens.com/sitrain  
 

Range of services 

Our range of services includes the following:  

• Plant data services 

• Spare parts services 

• Repair services  

• On-site and maintenance services 

• Retrofitting and modernization services 

• Service programs and contracts  

You can find detailed information on our range of services in the service catalog at: 
https://support.industry.siemens.com/cs/sc 
 

Industry Online Support app 

You will receive optimum support wherever you are with the "Siemens Industry 
Online Support" app. The App is available for Apple iOS, Android and Windows 
phones: 
https://support.industry.siemens.com/cs/ww/en/sc/2067 

https://support.industry.siemens.com/
https://www.siemens.com/industry/supportrequest
https://www.siemens.com/sitrain
https://support.industry.siemens.com/cs/sc
https://support.industry.siemens.com/cs/ww/en/sc/2067
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33.2 Links and Literature 

Table 33-1 

No. Topic 

\1\ Siemens Industry Online Support 

https://support.industry.siemens.com 

\2\ Entry page of the application sample  

https://support.industry.siemens.com/cs/ww/en/view/106226404 

\3\ Application example "Library with general functions (LGF) for STEP 7 (TIA Portal) 
and S7-1200 / S7-1500" 
https://support.industry.siemens.com/cs/ww/en/view/109479728 

\4\ "SIMATIC WinCC Advanced V14" Manual 
https://support.industry.siemens.com/cs/ww/en/view/109742297/91108514187 

\5\ "SIMATIC WinCC Advanced V14 SP1" Manual 

https://support.industry.siemens.com/cs/ww/en/view/109747174 

\6\ Application example "SIMATIC HMI Control Panels - Innovative Design and 
Operation" 

https://support.industry.siemens.com/cs/ww/en/view/91174767 

\7\ "SIMATIC HMI Devices Comfort Panels" Manual 

https://support.industry.siemens.com/cs/ww/en/view/49313233/99638204043 

\8\ Wikipedia entry on the topic "Reed Solomon" 
http://en.wikipedia.org/wiki/Reed%E2%80%93Solomon_error_correction 

\9\ FAQ "What are the functional differences between the different SIMATIC panels?" 

https://support.industry.siemens.com/cs/ww/en/view/40227286 

\10\ "SIMATIC WinCC Advanced V14 SP1 – Programming reference" Manual 
https://support.industry.siemens.com/cs/ww/en/view/109747176/76210564491 

\11\ Homepage of the barcode font provider "Logitogo" 
http://www.logitogo.com/html/barcode39_erstellen.html 

\12\ TIA Portal Openness: Introduction and Demo Application 

https://support.industry.siemens.com/cs/ww/en/view/108716692 

\13\ Microsoft Office Support entry "Show the Developer tab" 
https://support.office.com/en-us/article/show-the-developer-tab-e1192344-5e56-
4d45-931b-e5fd9bea2d45?ui=en-US&rs=en-US&ad=US 

\14\ Application example "SIMATIC HMI Option +" 

https://support.industry.siemens.com/cs/ww/en/view/109754400 

 

33.3 Change documentation 

Table 33-2 

Version Date Change 

V5.0 02/2019 • Release for documentation, library and project for 
V15.1 

 

https://support.industry.siemens.com/
https://support.industry.siemens.com/cs/ww/en/view/106226404
https://support.industry.siemens.com/cs/ww/en/view/109479728
https://support.industry.siemens.com/cs/ww/en/view/109742297/91108514187
https://support.industry.siemens.com/cs/ww/en/view/109747174
https://support.industry.siemens.com/cs/ww/en/view/91174767
https://support.industry.siemens.com/cs/ww/en/view/49313233/99638204043
http://en.wikipedia.org/wiki/Reed%E2%80%93Solomon_error_correction
https://support.industry.siemens.com/cs/ww/en/view/40227286
https://support.industry.siemens.com/cs/ww/en/view/109747176/76210564491
http://www.logitogo.com/html/barcode39_erstellen.html
https://support.industry.siemens.com/cs/ww/en/view/108716692
https://support.office.com/en-us/article/show-the-developer-tab-e1192344-5e56-4d45-931b-e5fd9bea2d45?ui=en-US&amp;amp;rs=en-US&amp;amp;ad=US
https://support.office.com/en-us/article/show-the-developer-tab-e1192344-5e56-4d45-931b-e5fd9bea2d45?ui=en-US&amp;amp;rs=en-US&amp;amp;ad=US
https://support.industry.siemens.com/cs/ww/en/view/109754400
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